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          Adobe Acrobat Reader 

Finding Words

You can use the Find command to find a complete word or part of a word in the current PDF document.  Acrobat Reader looks for the word by reading every word on every page in the file, including text in form fields.

To find a word using the Find command:

1. Click the Find button (Binoculars), or choose Edit > Find.

2. Enter the text to find in the text box.

3. Select search options if necessary:

Match Whole Word Only finds only occurrences of the complete word you enter in the box.  For example, if you search for the word stick, the words tick and sticky will not be highlighted.

Match Case finds only words that contain exactly the same capitalization you enter in the box.

Find Backwards starts the search from the current page and goes backwards through the document.

4. Click Find.  Acrobat Reader finds the next occurrence of the word.

To find the next occurrence of the word, Do one of the following:

            Choose Edit > Find Again 

            Reopen the find dialog box, and click Find Again. 
            (The word must already be in the Find text box.)

Copying and pasting text and graphics to another application

You can select text or a graphic in a PDF document, copy it to the Clipboard, and paste it into another application such as a word processor.  You can also paste text into a PDF document note or into a bookmark.  Once the selected text or graphic is on the Clipboard, you can switch to another application and paste it into another document.  

Note:  If a font copied from a PDF document is not available on the system displaying the copied text, the font cannot be preserved.  A default font  is substituted.

To select and copy it to the clipboard:

1. Select the text tool T, and do one of the following:

       To select a line of text, select the first letter of the sentence or phrase and drag to
       the last letter.  

To select multiple columns of text (horizontally), hold down Ctrl+Alt (Windows) or Option (Mac OS) as you drag across the width of the document. 

To select a column of text (vertically), Hold down Ctrl+Alt (Windows) or Option+Command (Mac OS) as you drag the length of the document.

To  select all the text on the page, choose Edit > Select All.  In single page mode, all the text on the current page is selected.  In Continuous or Continuous – facing mode, most of the text in the document is selected.  When you release the mouse button, the selected text is highlighted.  To deselect the text and start over, click anywhere outside the selected text.  

The Select All command will not select all the text in the document.  A workaround for this (Windows) is to use the Edit > Copy command.  Choose Edit > Copy to copy the selected text to the clipboard.

2. To view the text, choose Window > Show Clipboard

In Windows 95, the Clipboard Viewer is not installed by default and you cannot use the Show Clipboard command until it is installed.  To install the Clipboard Viewer, Choose Start > Settings > Control Panel > Add/Remove Programs, and then click the Windows Setup tab.  Double-click Accessories, check Clipboard Viewer, and click OK.

[REPORT OF ACTION TAKEN IN CLOSED SESSION
ON JANUARY 15, 2008, BEGINS ON PAGE 74.]
SUP. BURKE, CHAIR: THE INVOCATION WILL BE LED BY MONSIGNOR JAMES LOUGHNANE, PASTOR OF ST. DENIS CATHOLIC COMMUNITY CHURCH, FROM DIAMOND BAR OF THE FOURTH DISTRICT. THE PLEDGE OF ALLEGIANCE WILL BE LED BY JERRY KING, COMMANDER OF THE POST NUMBER 617, CULVER CITY, JEWISH WAR VETERANS. WOULD YOU PLEASE STAND? MONSIGNOR? 

MONSIGNOR JAMES LOUGHNANE: BLESSED ARE YOU, GOD OF ALL CREATION. THROUGH YOUR LOVE AND GOODNESS, YOU HAVE FORMED US IN YOUR IMAGE AND LIKENESS AND MADE US STEWARDS OF THAT CREATION. YOU CALL US TO USE OUR GIFTS AND TALENTS IN OUR POSITIONS OF LEADERSHIP AND VOCATIONS IN LIFE. YOU CALL US ESPECIALLY TO BE INSTRUMENTS OF JUSTICE AND LOVE, COMPASSION AND FORGIVENESS. AND BY LIVING THESE VIRTUES TO BRING PEOPLE OF DIFFERENT CULTURES, IDEOLOGIES AND BELIEFS CLOSER TOGETHER AS EQUAL MEMBERS OF THE HUMAN FAMILY. WE THANK YOU FOR WHAT HAS BEEN ACCOMPLISHED IN THESE AREAS THUS FAR, THAT THOSE ACHIEVEMENTS ENCOURAGE US TO MOVE FORWARD WITH GREATER ENTHUSIASM AND RESOLVE. WE ACCOMPLISH IN OUR LIFETIME ONLY A TINY FRACTION OF THE MAGNIFICENT ENTERPRISE THAT IS GOD'S WORK. NOTHING WE DO IS COMPLETE, WHICH IS ANOTHER WAY OF SAYING THAT THE KINGDOM ALWAYS LIES BEYOND US. NO STATEMENT SAYS ALL THAT SHOULD BE SAID, NO PRAYER FULLY EXPRESSES OUR FAITH, NO CONFESSION BRINGS PERFECTION, NO PASTORAL VISIT BRINGS WHOLENESS, NO PROGRAM ACCOMPLISHES THE CHURCH'S MISSION, AND NO SET OF GOALS AND OBJECTIVES INCLUDES EVERYTHING. THAT IS WHAT WE ARE ABOUT. WE PLANT SEEDS THAT ONE DAY WILL GROW. WE WATER SEEDS ALREADY PLANTED, KNOWING THAT THEY HOLD FUTURE PROMISE. WE LAY FOUNDATIONS THAT WILL NEED FURTHER DEVELOPMENT. WE PROVIDE YEAST THAT PRODUCES EFFECTS FAR BEYOND OUR CAPABILITIES. WE CANNOT DO EVERYTHING AND THERE IS A SENSE OF LIBERATION IN REALIZING THAT. THIS ENABLES US TO DO SOMETHING AND TO DO IT VERY WELL. IT MAY BE INCOMPLETE, BUT IT IS A BEGINNING, A STEP ALONG THE WAY, AN OPPORTUNITY FOR THE LORD'S GRACE TO ENTER AND DO THE REST. WE MAY NEVER SEE THE END RESULTS, BUT THAT IS THE DIFFERENCE BETWEEN THE MASTER BUILDER AND THE WORKER. WE ARE WORKERS, NOT MASTER BUILDERS, MINISTERS, NOT MESSIAHS. WE ARE PROPHETS OF A FUTURE THAT IS NOT OUR OWN. WE ASK YOU, OH GOD, TO GIVE YOUR BLESSING TO THIS COUNTY OF LOS ANGELES. MAY ITS CITIZENS COMMIT TO BUILDING BRIDGES OF FRIENDSHIP, UNDERSTANDING, AND COOPERATION. BLESS OUR SUPERVISORS, THEIR STAFFS, AND THE MANY AGENCIES THAT SERVE THE COMMON GOOD OF THE COUNTY. GIVE YOUR WISDOM AND GUIDANCE TO THOSE ENTRUSTED WITH THE RESPONSIBILITY OF ENACTING LAWS THAT GOVERN THE LIVES OF OUR CITIZENS. MAY YOUR SPIRIT OF WISDOM GUIDE THE JUDICIAL SYSTEM SO THAT A SENSE OF FAIRNESS, JUSTICE, AND COMPASSION MAY GUIDE EVERY DECISION. PROTECT OUR POLICE, SHERIFFS, FIRE FIGHTERS, PARAMEDICS, AND ALL OTHERS CALLED TO RESPOND TO EMERGENCY SITUATIONS. BE WITH OUR YOUNG MEN AND WOMEN SERVING IN THE ARMED FORCES AT HOME AND ABROAD. KEEP THEM FROM HARM'S WAY AND RETURN THEM SOON AND SAFELY TO THEIR FAMILIES. BLESS THE MANY CITIES, CIVIC LEADERS, BUSINESS OWNERS AND RESIDENTS WHO MAKE UP THIS COUNTY. SHOWER YOUR BLESSING ON THE MANY INSTITUTIONS OF LEARNING AND GUIDE THOSE ENTRUSTED WITH THE CARE OF OUR CHILDREN AND YOUTH. REMOVE VIOLENCE FROM OUR HOMES AND STREETS, RECONCILE ALL WARRING FACTIONS, AND HELP OUR COMMUNITIES TO LIVE IN PEACE AND HARMONY. BLESS THE POOR, THE HOMELESS, AND THE MARGINALIZED. LET US ALWAYS SEE THEM AND TREAT THEM AS SISTERS AND BROTHERS. BLESS THOSE IN THE COUNTY WHO ARE SEEKING EMPLOYMENT AT THIS TIME, THAT THEY MAY FIND SATISFACTION IN EARNING THEIR DAILY BREAD BY PROVIDING FOR THEIR FAMILIES. GIVE YOUR BLESSING TO THOSE WHO SERVE IN THE HEALTHCARE PROFESSION, IN SOCIAL WORK, THE ARTS AND SCIENCES, AND ALL WHO PROVIDE RESOURCES TO ENHANCE THE LIVES OF OUR CITIZENS. BLESS THE MANY COMMUNITIES OF FAITH IN OUR COUNTY AND HELP THEM TO GLORIFY YOUR NAME BY WORKING TOGETHER FOR THE BUILDING UP OF YOUR KINGDOM. BLESS ALL THOSE GATHERED FOR THIS MEETING THIS MORNING, GIVE OUR SUPERVISORS AND ALL PARTICIPANTS THE WISDOM AND COURAGE TO WORK TOGETHER FOR THE GOOD OF ALL OUR CITIZENS. MAY THE CHALLENGES BEFORE US STRENGTHEN OUR RESOLVE TO RELY ON YOU TO GUIDE US TODAY AND ALWAYS. AMEN. 

JERRY KING: PLEASE FACE THE FLAG. PUT YOUR RIGHT HAND OVER YOUR HEART AND JOIN ME IN THE PLEDGE OF ALLEGIANCE. [ PLEDGE OF ALLEGIANCE ] 

SUP. BURKE, CHAIR: SUPERVISOR KNABE? 

SUP. KNABE: THANK YOU. MADAM CHAIR, MEMBERS OF THE BOARD, LADIES AND GENTLEMEN, IT'S MY PLEASURE TO ONCE AGAIN INTRODUCE MONSIGNOR JAMES LOUGHNANE, WHO IS THE PASTOR, AS WAS MENTIONED, AT THE ST. DENIS CATHOLIC COMMUNITY CHURCH IN DIAMOND BAR. FATHER LOUGHNANE WAS ORDAINED AT THE ALL HALLOWS SEMINARY IN DUBLIN, IRELAND, ON JUNE 18TH IN 1961, FOR MINISTRY RIGHT HERE IN THE ARCHDIOCESE OF LOS ANGELES, AND SIX WEEKS LATER, REPORTED TO DUTY. IN THOSE 46-PLUS YEARS, HE HAS SERVED IN GRENADA HILLS, LONG BEACH, HUNTINGTON BEACH, CANOGA PARK, AND NOW DIAMOND BAR. IN NOVEMBER OF 2005, MONSIGNOR LOUGHNANE WAS GIVEN THE HONOR OF PROTONOTARY APOSTOLIC BY POPE BENEDICT, THE HIGHEST RANK OF MONSIGNOR. HE MAINTAINS A GOOD WORKING RELATIONSHIP AND IS VERY WELL KNOWN IN THE CITY OF DIAMOND BAR AND CITY OF GOVERNMENTS IN GENERAL AND HE WORKS VERY HARD TO BRING THE CHURCHES OF DIAMOND BAR TOGETHER FOR MANY DIFFERENT EVENTS THROUGHOUT THE YEAR. SO IT'S MY PLEASURE TO PRESENT THIS CERTIFICATE OF APPRECIATION TO FATHER LOUGHNANE AND TO ONCE AGAIN THANK HIM FOR TAKING THE TIME TO COME DOWN AND LEAD US IN THE INVOCATION. [ APPLAUSE ] 

SUP. YAROSLAVSKY: MADAM CHAIR, WE WERE LED IN THE PLEDGE OF ALLEGIANCE THIS MORNING BY JERRY KING, REPRESENTING THE JEWISH WAR VETERANS POST NUMBER 617 OF CULVER CITY. JERRY SERVED IN THE UNITED STATES ARMY AIR CORPS FROM 1942 THROUGH '45, IN THE NINTH TROOP CARRIER COMMAND, SERVED IN NORTH AFRICA, AND IN THE EUROPEAN THEATER, AND PARTICIPATED IN A NUMBER OF BATTLES. HE RECEIVED THE PRESIDENTIAL UNIT CITATION WITH TWO CLUSTERS, ARMY GOOD CONDUCT MEDAL, THE AMERICAN CAMPAIGN MEDAL, EUROPEAN AFRICAN CAMPAIGN MEDAL WITH 10 STARS, WORLD WAR II VICTORY MEDAL, WORLD WAR II OCCUPATION MEDAL, AMONG OTHERS. HE'S A 60-YEAR RESIDENT OF OUR COUNTY AND OUR DISTRICT, BUT HE ORIGINALLY HAILS FROM NEW YORK CITY WHERE HE ATTENDED EVANDER CHILDS HIGH SCHOOL AND ST. JOHN'S UNIVERSITY. JERRY, THANK YOU FOR LEADING US IN THE PLEDGE THIS MORNING AND FOR YOUR SERVICE TO OUR COUNTRY. [ APPLAUSE ] 

CLERK SACHI HAMAI: GOOD MORNING, MADAM CHAIR, MEMBERS OF THE BOARD. WE WILL BEGIN TODAY'S AGENDA ON PAGE 2, PRESENTATIONS, SET MATTERS. ON ITEM S-1, AS INDICATED ON THE POSTED AGENDA, THE CHIEF EXECUTIVE OFFICER REQUESTS THAT THIS ITEM BE CONTINUED TO FEBRUARY 19, 2008, AND THERE IS ALSO A REQUEST FROM A MEMBER OF THE PUBLIC TO HOLD THIS ITEM. 

SUP. BURKE, CHAIR: WE'LL HOLD IT AND THEN WE'LL CONTINUE IT. 

CLERK SACHI HAMAI: AGENDA FOR THE MEETING OF THE COMMUNITY DEVELOPMENT COMMISSION, ITEM 1-D. 

SUP. BURKE, CHAIR: MOVED BY KNABE, SECONDED BY MOLINA. WITHOUT OBJECTION, SO ORDERED. I'M SORRY. MOVED BY ANTONOVICH, SECONDED BY KNABE. WITHOUT OBJECTION, SO ORDERED. 

CLERK SACHI HAMAI: BOARD OF SUPERVISORS, ITEMS 1 THROUGH 8. ON ITEM NUMBER 2, AS INDICATED ON THE SUPPLEMENTAL AGENDA, SUPERVISOR BURKE REQUESTS THAT THIS ITEM BE CONTINUED TWO WEEKS TO JANUARY 29TH, 2008. 

SUP. BURKE, CHAIR: ON THE REMAINDER, MOVED BY KNABE, SECONDED BY MOLINA. WITHOUT OBJECTION, SO ORDERED. 

CLERK SACHI HAMAI: CONSENT CALENDAR, ITEMS 9 THROUGH 50. ON ITEM NUMBER 9, SUPERVISOR KNABE REQUESTS THAT THIS ITEM BE HELD. ON ITEM NUMBER 12, AS INDICATED ON THE SUPPLEMENTAL AGENDA, THE CHIEF EXECUTIVE OFFICER REQUESTS THAT THIS ITEM BE CONTINUED ONE WEEK TO JANUARY 22ND, 2008. 

SUP. YAROSLAVSKY: WHICH ITEM WAS THAT? 

SUP. BURKE, CHAIR: ON 12? 

CLERK SACHI HAMAI: 12. 

SUP. BURKE, CHAIR: WITHOUT OBJECTION, IT'S CONTINUED. 

CLERK SACHI HAMAI: ON ITEM NUMBER 13, THERE'S A REQUEST FROM A MEMBER OF THE PUBLIC TO HOLD THIS ITEM. ON ITEM NUMBER 15, THERE'S A REQUEST FROM A MEMBER OF THE PUBLIC TO HOLD THIS ITEM. ON ITEM NUMBER 16, SUPERVISOR ANTONOVICH REQUESTS THAT THIS ITEM BE CONTINUED ONE WEEK TO JANUARY 22ND, 2008. 

SUP. BURKE, CHAIR: WITHOUT OBJECTION. 

CLERK SACHI HAMAI: ON ITEM NUMBER 18, THERE'S A REQUEST FROM A MEMBER OF THE PUBLIC TO HOLD THIS ITEM. ON ITEM NUMBER 25, AS INDICATED ON THE SUPPLEMENTAL AGENDA, THE DIRECTOR OF PUBLIC HEALTH REQUESTS THAT THIS ITEM BE CONTINUED TWO WEEKS TO JANUARY 29TH, 2008. 

SUP. BURKE, CHAIR: UNLESS THERE'S OBJECTION, WE WILL CONTINUE THIS ITEM. 

CLERK SACHI HAMAI: ON ITEM NUMBER 26, THERE IS A REQUEST FROM A MEMBER OF THE PUBLIC TO HOLD THIS ITEM. ON ITEM NUMBER 32, THE CHIEF EXECUTIVE OFFICER REQUESTS THAT THIS ITEM BE CONTINUED TWO WEEKS TO JANUARY 29TH, 2008. AND THERE'S ALSO A REQUEST FROM A MEMBER OF THE PUBLIC TO HOLD THIS ITEM. AND THE REMAINING ITEMS ARE BEFORE YOU. 

SUP. BURKE, CHAIR: ON THE REMAINING, MOVED BY MOLINA, SECONDED BY YAROSLAVSKY. WITHOUT OBJECTION, SO ORDERED. 

CLERK SACHI HAMAI: WE ARE NOW ON PAGE 23, ORDINANCES FOR INTRODUCTION, ITEMS 51 AND 52. ON ITEM 51, AS INDICATED ON THE SUPPLEMENTAL AGENDA, THE CHIEF EXECUTIVE OFFICER REQUESTS THAT THIS ITEM BE CONTINUED ONE WEEK TO JANUARY 22ND, 2008. 

SUP. BURKE, CHAIR: WITHOUT OBJECTION, THAT'S CONTINUED. 

CLERK SACHI HAMAI: ON ITEM NUMBER 52, I'LL READ THE SHORT TITLE IN FOR THE RECORD. THIS IS AN ORDINANCE AMENDING TITLE 6, SALARIES OF THE LOS ANGELES COUNTY CODE, RELATING TO CHANGING THE SALARY OF THE DISTRICT ATTORNEY, WHOSE TERM OF OFFICE BEGINS ON OR AFTER DECEMBER 1ST, 2008. THERE'S A REQUEST FROM A MEMBER OF THE PUBLIC TO HOLD THIS ITEM. 

SUP. BURKE, CHAIR: WE'LL HOLD THAT ITEM. 

CLERK SACHI HAMAI: MISCELLANEOUS ADDITIONS TO THE AGENDA WHICH WERE POSTED MORE THAN 72 HOURS IN ADVANCE OF THE MEETING AS INDICATED ON THE SUPPLEMENTAL AGENDA. ITEM 53-A, THERE'S A REQUEST FROM A MEMBER OF THE PUBLIC TO HOLD THIS ITEM. 53-B. 

SUP. BURKE, CHAIR: MOVED BY YAROSLAVSKY, SECONDED BY ANTONOVICH. WITHOUT OBJECTION, SO ORDERED. 

CLERK SACHI HAMAI: ON PAGE 26, NOTICE OF CLOSED SESSION. ON ITEM CS-1, THERE'S A REQUEST FROM A MEMBER OF THE PUBLIC TO HOLD THIS ITEM. AND THAT COMPLETES THE READING OF THE AGENDA. BOARD OF SUPERVISORS' SPECIAL ITEMS BEGINS WITH SUPERVISORIAL DISTRICT NUMBER 1. 

SUP. BURKE, CHAIR: WE HAVE A NEW CONSUL GENERAL THAT WE'D LIKE TO RECOGNIZE. CAN YOU HEAR ME ON THIS? OH, OKAY. WELL, WE'RE VERY PLEASED TO INTRODUCE THE HONORABLE JACOB DAYAN, CONSUL GENERAL OF ISRAEL IN LOS ANGELES. CONSUL GENERAL DAYAN HAS BEEN CHIEF OF STAFF TO THE DEPUTY PRIME MINISTER AND MINISTER OF FOREIGN AFFAIRS. IN THIS POSITION, HE WAS INTIMATELY INVOLVED WITH POLICY FORMATION, DECISION MAKING AND IMPLEMENTATION. BEFORE THAT, HE WAS A POLICY ADVISOR TO THE MINISTER OF FOREIGN AFFAIRS, WITH RESPONSIBILITY FOR U.S., ASIA, EASTERN EUROPE AND MIDDLE EASTERN AFFAIRS. HE GRADUATED MAGNA CUM LAUDE FROM TEL AVIV UNIVERSITY WITH A BACHELOR OF ART DEGREE IN CLASSICS AND HISTORY, AND HAS DONE GRADUATE WORK IN HISTORICAL STUDIES. BEFORE HIS APPOINTMENT TO LOS ANGELES, CONSUL GENERAL DAYAN WAS SELECTED TO PREPARE A STRATEGIC PLAN ON THE FEASIBILITY OF OPENING NEGOTIATIONS WITH SYRIA. HE IS BEING JOINED IN LOS ANGELES BY HIS WIFE, GALIT, AND THEIR THREE CHILDREN. ON BEHALF OF THE MORE THAN 10 MILLION PEOPLE OF LOS ANGELES COUNTY AND THE BOARD OF SUPERVISORS, I AM VERY PLEASED TO WELCOME CONSUL GENERAL DAYAN. 

CONSUL GENERAL DAYAN: THANK YOU VERY MUCH. 

SUP. BURKE, CHAIR: WE LOOK FORWARD TO WORKING WITH YOU. 

CONSUL GENERAL DAYAN: THANK YOU VERY MUCH. [ APPLAUSE ] 

SUP. BURKE, CHAIR: WE'LL GET A PICTURE WITH ALL THE MEMBERS, BUT WE'D LIKE FOR YOU TO SPEAK FIRST. 

CONSUL GENERAL DAYAN: OKAY, GLADLY. THANK YOU VERY MUCH, BOARD OF SUPERVISORS. I'M HONORED. AND, ACTUALLY, I DON'T KNOW IF YOU KNOW HOW MUCH RESPONSIBILITY YOU BEAR UPON YOUR SHOULDERS ON BEHALF OF THE STATE OF ISRAEL. BECAUSE THIS IS THE SECOND LARGEST JEWISH REGION IN THE WORLD. SO IN TERMS OF THE PERSPECTIVE OF THE STATE OF ISRAEL, WE COUNT ON YOU. WE WOULD LIKE TO TELL YOU THAT ISRAEL HAS A VERY SPECIAL YEAR THIS YEAR, BECAUSE WE CELEBRATE OUR 60TH ANNIVERSARY. SOME WILL SAY OUR 3,060TH ANNIVERSARY. AND THAT'S A GREAT YEAR TO PRESENT TO THE PEOPLE OF LOS ANGELES THE AMAZING ACHIEVEMENTS OF THE STATE OF ISRAEL. ONLY TODAY WE HAVE 14 ISRAELI COMPANIES THAT ARE REPRESENTING OUR AMAZING TECHNOLOGICAL ACHIEVEMENTS IN HOMELAND SECURITY AND WE ARE, WE HOPE TO COOPERATE WITH YOU ON VARIOUS FIELDS LIKE CLEAN TECH AND HIGH TECH SOLAR ENERGY. YOU CAN REALLY COUNT ON THE TECHNOLOGY OF THE STATE OF ISRAEL, BECAUSE WE HAVE ONE RESOURCE THAT NEVER DRIES, AND THAT'S THE HUMAN POWER, THE HUMAN RESOURCE IN ISRAEL. AND ISRAEL IS VERY SIMILAR TO LOS ANGELES. I SAW AT THE ENTRANCE THAT YOU ARE CELEBRATING YOUR CULTURAL DIVERSITY. AND ISRAEL CELEBRATES ON A DAILY BASIS ITS CULTURAL DIVERSITY. WE HAVE PEOPLE FROM 120 DIFFERENT COUNTRIES LIVING IN ISRAEL, AND THE SIMILARITY TO LOS ANGELES IS STRIKING. JUST TO FINISH, I THINK IN SIX DAYS, WE ARE ALL GOING TO CELEBRATE THE ANNIVERSARY OF THE HERO MARTIN LUTHER KING. AND IN HIS WORDS, I WILL SAY I HAVE A DREAM, TO SEE ISRAEL PROSPEROUS, PEACE, AND TRANQUILITY, SUCH AS YOU HAVE IN LOS ANGELES. THANK YOU VERY MUCH FOR HAVING ME. [ APPLAUSE ] 

SUP. BURKE, CHAIR: THANK YOU. WE'D LIKE TO GET A PICTURE WITH ALL OF YOU. [ INDISTINCT CONVERSATION ] 

SUP. BURKE, CHAIR: SUPERVISOR MOLINA, DO YOU HAVE ANY PRESENTATIONS? 

SUP. MOLINA: NO, I DO NOT. 

SUP. BURKE, CHAIR: OKAY. SHOULD WE WAIT? DO WE HAVE... ARE THEY HERE? WE'LL DO THIS FIRST, SEE IF THE OTHER PEOPLE COME? I'D LIKE TO CALL FORWARD ELLEN EIDEM, PATTY JURIG, SARINA ARAUJO, AND RACHEL BIETY OF THE LOS ANGELES COUNTY OFFICE OF WOMEN'S HEALTH, AND NATIONAL CERVICAL CANCER COALITION FOUNDER, ALAN KAYE. WOULD YOU PLEASE COME FORWARD? IN THE UNITED STATES, APPROXIMATELY 11,150 WOMEN ARE DIAGNOSED WITH CERVICAL CANCER EACH YEAR, AND 3,670 WOMEN DIE FROM THE DISEASE. THE RATES OF CERVICAL CANCER ARE SIGNIFICANTLY HIGHER THAN THE NATIONAL RATE OF 8.7 PER 100,000 WOMEN IN LOW INCOME, UNINSURED WOMEN OF COLOR, RECENT IMMIGRANTS, AND OLDER WOMEN. THEY HAVE A SIGNIFICANTLY HIGHER INCIDENCE. CERVICAL CANCER IS PREVENTABLE, WITH ROUTINE PAP SMEARS AND H.P.V. TESTING. DEATHS FROM THE DISEASE ARE CAUSED MAINLY BECAUSE OF NON-AWARENESS AND ACCESS TO EARLY DETECTION. THE NATIONAL CERVICAL CANCER COALITION FOUNDED IN 1996 IN LOS ANGELES BY RANDI AND ALAN KAYE, IS A GRASSROOTS NONPROFIT ORGANIZATION THAT HAS GROWN TO 4,500 MEMBERS WORLDWIDE AND DEDICATED TO SERVING WOMEN WITH OR AT RISK OF CERVICAL CANCER AND H.P.V. THE ORGANIZATION PROVIDES SUPPORT SERVICES, INCLUDING AN AWARD WINNING WEB SITE. THE FIRST CERVICAL CANCER PHONE LIFELINE FOR WOMEN AND FAMILY MEMBERS AND THE PHONE PAL SUPPORT SYSTEM MATCHING TOGETHER WOMEN WHO ARE BATTLING CERVICAL CANCER AND H.P.V. INFECTION. IT IS WITH GREAT PLEASURE THAT I PRESENT THESE SCROLLS TO ELLEN EIDEM, JESSICA ST. JOHN, PATTY JURIG, SARINA ARAUJO, AND RACHEL BIETY OF THE LOS ANGELES COUNTY OFFICE OF WOMEN'S HEALTH AND NATIONAL CERVICAL CANCER COALITION FOUNDER, ALAN KAYE, FOR THEIR DEDICATED AND COURAGEOUS FIGHT AGAINST CERVICAL CANCER. WE'LL TAKE ONE WITH YOU AND THEN WE'LL GET EVERYONE IN. 

ALAN KAYE: THANK YOU, SUPERVISOR BURKE, FOR THE RECOGNITION ON THE ONGOING SUPPORT THAT THE BOARD OF SUPERVISORS HAS GIVEN TO THE NATIONAL CERVICAL CANCER COALITION AND THE FOCUS THAT YOU'VE ALL PROVIDED THROUGH THE DEPARTMENT OF HEALTH AND THE GREAT WORK THEY DO IN OUTREACH FOR CERVICAL CANCER AND THE COUNTY OF LOS ANGELES. THERE ARE MANY WOMEN THAT ARE BATTLING ISSUES RELATED TO CERVICAL CANCER AND THE COUNTY HAS PROVIDED A MULTI-LANGUAGE PHONE BANK AND PROVIDED OUTSOURCE INFORMATION TO THE COUNTY AND WE APPRECIATE THE AWARENESS KNOWING IT'S OF ALMOST EPIDEMIC PROPORTIONS IN L.A. COUNTY, AND ALL THE WORK THAT YOU IN THE DEPARTMENT AND THE OFFICE OF WOMEN'S HEALTH HAS DONE. THANK YOU FOR ALL YOUR OUTREACH. 

SUP. BURKE, CHAIR: WELL, CONGRATULATIONS. DO YOU WANT TO SAY A WORD? 

ELLEN EIDEM: I'M ELLEN FROM THE OFFICE OF WOMEN'S HEALTH. THANK YOU TO SUPERVISOR BURKE, ALSO THE SUPERVISORS FOR THEIR ONGOING SUPPORT IN CERVICAL CANCER AWARENESS AND ALL OF WOMEN'S HEALTH ISSUES. AGAIN, NO WOMAN SHOULD DIE OF CERVICAL CANCER, GIVEN THE FACT THAT IT'S BOTH PREVENTABLE AND TREATABLE. AND YET IN AN OFFICE LIKE OUR OWN, THE OFFICE OF WOMEN'S HEALTH, WE HAD A YOUNG RELATIVE OF A WOMAN IN OUR OWN OFFICE DIE THIS MONTH OF CERVICAL CANCER. SO WE NEED TO BE AWARE, NOT ONLY AND COMMUNICATE TO THE PEOPLE THAT WE LOVE. SO THANK YOU TO ALL THAT ARE DOING THE WORK. THANK YOU TO THE NATIONAL COALITION FOR CERVICAL CANCER AND THANK YOU FOR ALL THAT THEY'RE DOING. APPRECIATE IT. 

SUP. BURKE, CHAIR: CAN WE GET A PICTURE WITH EVERYONE? THANK YOU. YOU'RE DOING A GREAT JOB. 

ELLEN EIDEM: THANK YOU VERY MUCH. 

SUP. BURKE, CHAIR: THANK YOU. WE WOULD NOW LIKE TO CALL FORWARD THE KINGDOM DAY PARADE. IS LARRY GRANT HERE YET? WELL, WE'LL GO FORWARD. BUT MASTER CHUN'S HERE. AND, OF COURSE, THE 23RD ANNUAL QUEEN, ADRIANA CONSTANT, AND SHE'S THE FIRST, AND THE FIRST RUNNER UP, WYVETTA TAYLOR, AND THE SECOND RUNNER UP, KAMERON BROWN, AND VICE PRESIDENT OF THE NATIONAL CULTURAL FOUNDATION, INC., DESHAUN WILLIAMS. EACH YEAR, MARTIN LUTHER KING, JR. KINGDOM PARADE IS HELD ON JANUARY 21ST, KING'S BIRTHDAY. WELL, IT'S REALLY HELD ON THE MONDAY FOLLOWING HIS BIRTHDAY, WHICH IS JANUARY 15TH. THIS PARADE DRAWS TENS OF THOUSANDS OF SPECTATORS AND COMMUNITY MEMBERS. EACH YEAR, A KING DAY PARADE QUEEN AND HER COURT ARE SELECTED BASED ON A SUBMITTED ESSAY DETAILING THE CONTESTANTS' EDUCATION, BACKGROUND AND THEIR PARTICIPATION IN COMMUNITY ACTIVITIES. THIS IS A COURT OF EXCEPTIONALLY DEDICATED YOUNG WOMEN, ALL OF DIVERSE ETHNIC BACKGROUNDS. AND I'M PLEASED TO HONOR THEM HERE TODAY. QUEEN ADRIANA CONSTANT IS A 19-YEAR-OLD SOPHOMORE AT CAL STATE LONG BEACH, WHOSE MOTHER IS FROM OUR STAFF, MARIA SERTIS, AND WHOSE MAJOR IS POLITICAL SCIENCE. AND WE ARE SO PLEASED, BECAUSE WE'VE WATCHED HER GROW UP, AND SHE'S BEEN VERY ACTIVE IN ALL OF OUR ACTIVITIES HERE IN THE COUNTY OF LOS ANGELES. THE PRINCESS AND FIRST RUNNER UP, WYVETTA TAYLOR, A JUNIOR AT VIEWPARK ACCELERATED PREPARATORY HIGH SCHOOL, WHERE SHE MAINTAINS A 3.87 G.P.A., TAKING BOTH HONORS AND A.P. CLASSES. SECOND RUNNER UP IS KAMERON BROWN, A 19-YEAR-OLD SOPHOMORE AT CAL STATE LONG BEACH MAJORING IN COMMUNICATION. THIS YEAR'S PARADE IS TO BE HELD FROM 11:00 A.M. TO 1:00, BEGINNING ON WESTERN AVENUE AND M.L.K. BOULEVARD, DOWN CRENSHAW, ENDING ON VERNON AVENUE. I ENCOURAGE YOU ALL TO COME ON DOWN AND ENJOY THE 23RD ANNUAL KINGDOM DAY PARADE. OR YOU CAN ALWAYS WATCH IT ON TELEVISION. AND IT'S WITH GREAT HONOR THAT I PRESENT THESE SCROLLS TODAY TO KINGDOM DAY PARADE SUPPORTER MASTER CHUN. AND WHEN LARRY GRANT GETS HERE, WE'LL PRESENT HIS TO HIM SEPARATELY, IF HE MAKES IT. BUT WE ALSO WANT TO RECOGNIZE THE QUEEN AND HER COURT. SO, FIRST, ADRIANA. [ APPLAUSE ] 

SUP. BURKE, CHAIR: AND WE'RE GOING TO HAVE YOUR MOTHER UP IN A FEW MINUTES LATER. IS WYVETTA TAYLOR HERE? WYVETTA TAYLOR. IS KAMERON BROWN HERE? ALL RIGHT. AND TO KINGDOM DAY SPONSORS. MASTER CHUN, WOULD YOU COME FORWARD AND TAKE THE, AND ACCEPT THESE FOR THEM? AND WHEN THEY GET HERE, WE'LL TAKE A PHOTO. ADRIANA, WOULD YOU LIKE TO SAY A WORD? 

ADRIANA CONSTANT: IT IS TRULY HUMBLING TO BE SURROUNDED BY SO MANY DISTINGUISHED PEOPLE. I'D LIKE TO THANK SUPERVISOR YVONNE BURKE FOR THIS RECOGNITION AND THE KINGDOM DAY PARADE COMMITTEE FOR ALLOWING ME TO REPRESENT THEM. AS BEAUTIFUL AS THIS CROWN IS, IT BECOMES MEANINGLESS IF WE FAIL TO REMEMBER THE MAN THAT WE ARE HONORING AND THE IMPACT THAT HE HAS MADE ON OUR LIVES. DR. MARTIN LUTHER KING, JR., HAS HELPED CREATE OPPORTUNITIES FOR EQUALITY NOT ONLY FOR AFRICAN AMERICANS, BUT FOR ALL RACES. IT IS EXTREMELY PLEASING TO SEE THAT THE PARADE IS BECOMING MORE DIVERSE. AND IT IS NICE TO SEE SO MANY INDIVIDUALS COME TOGETHER AND COMMEMORATE SUCH AN AMAZING PERSON. 

SUP. BURKE, CHAIR: OKAY. WE'RE GOING TO ASK MARIA TO COME FORWARD AND WE'LL TAKE A PICTURE WITH HER. OKAY. WE'LL GET YOU IN THE MIDDLE. THANK YOU. 

MASTER TONG SUK CHUN: THANK YOU SO MUCH, MRS. SUPERVISOR. 

SUP. BURKE, CHAIR: THAT CONCLUDES MY PRESENTATIONS. SUPERVISOR YAROSLAVSKY? OKAY. WHEN HE GETS HERE, WE'LL TAKE A PICTURE. IS ANYBODY ELSE GOING TO BE HERE? 

SUP. YAROSLAVSKY: I'D LIKE TO ASK DR. JONATHAN FIELDING TO COME FORWARD. ALONG WITH NIDHI NAKRA, WHO IS DIRECTOR OF THE COMMUNITY OUTREACH AND EDUCATION FOR THE DEPARTMENT OF PUBLIC HEALTH IMMUNIZATION PROGRAM. WENDY BERGER, WHO IS THE COORDINATOR OF THE IMMUNIZATION COALITION OF LOS ANGELES COUNTY. DEBORAH ROSEN, DIRECTOR OF PUBLIC HEALTH PROGRAMS AND CHRONIC DISEASE AND NORTHEAST VALLEY HEALTH VALLEY CORPORATION, AND DR. MARLENE LUGG, IMMUNIZATION COORDINATOR OF KAISER IN PANORAMA CITY. AND WE'VE ASKED ALL OF THESE DISTINGUISHED INDIVIDUALS TO COME FORWARD TODAY TO ACCEPT THIS PROCLAMATION FROM THE BOARD OF SUPERVISORS FOR THE PROCLAMATION OF PRE-TEEN VACCINE WEEK, JANUARY 20TH THROUGH 26TH IS BEING PROCLAIMED AS PRE-TEEN VACCINE WEEK. PRE-TEENS NEED IMMUNIZATIONS TO BOOST THE PROTECTION THEY RECEIVE FROM BABY SHOTS AND TO BE PROTECTED FROM OTHER SERIOUS DISEASES LATER IN LIFE, SUCH AS MENINGOCOCCAL MENINGITIS, WHOOPING COUGH AND CERVICAL CANCER. A DOCTOR VISIT HELPS PRE-TEENS STAY UP TO DATE WITH IMMUNIZATIONS AND SERVES TO REDUCE THE SPREAD OF VACCINE-PREVENTABLE DISEASES TO FAMILY MEMBERS, CLASSMATES AND THE COMMUNITY. THE FEDERAL ADVISORY COMMITTEE ON IMMUNIZATION PRACTICES RECOMMENDS THAT 11 AND 12 YEAR OLDS RECEIVE A MENINGOCOCCAL VACCINATION, A T-DAP, THAT IS TETANUS, DIPHTHERIA, AND PERTUSSIS BOOSTER, A BOOSTER SHOT. AND FOR GIRLS, IMMUNIZATION AGAINST HUMAN -- OH, MAN -- PAPILLOMA. THAT'S THE LAST TIME I'M DOING A PROCLAMATION FOR PUBLIC HEALTH, I'LL TELL YOU THAT. PUT IT IN ENGLISH, NOT IN LATIN, NEXT TIME, OKAY? THE COALITION OF CONCERNED BUSINESSES AND PUBLIC HEALTH AND COMMUNITY ORGANIZATIONS IN LOS ANGELES HAVE JOINED TOGETHER TO RAISE PUBLIC AWARENESS ABOUT PRE-TEEN VACCINES, AND TO BRING ATTENTION TO THE NEED FOR TIMELY IMMUNIZATIONS, AND THAT'S THE PURPOSE FOR THIS PROCLAMATION AND FOR OUR BEING HERE TODAY. SO WE RESOLVE THAT THE BOARD OF SUPERVISORS OF LOS ANGELES COUNTY PROCLAIM JANUARY 20TH THROUGH 26TH, 2008, AS PRE-TEEN VACCINE WEEK, AND HOPE THAT EVERYONE WITHIN THE SOUND OF OUR VOICES TAKE THE OPPORTUNITY TO APPROPRIATELY ACCESS HEALTHCARE VENUES, EITHER OURS OR THE NONPROFITS, OR THEIR OWN DOCTORS WHO PROVIDE THESE KINDS OF SERVICES, THESE VACCINES, AND TAKE CARE OF BUSINESS. BECAUSE IT REALLY IS AN INVESTMENT IN THE HEALTH OF OUR YOUNGER POPULATION. SO DR. FIELDING, IF YOU'LL ACCEPT THIS AND SAY A COUPLE WORDS. COME ON, WE'LL TAKE A PICTURE FIRST. 

DR. JONATHAN FIELDING: THANK YOU VERY MUCH, SUPERVISOR. WHEN YOU SEE PRE-TEENS, THEY TEND TO GO SEE DOCTORS LESS, AND WHAT'S REALLY IMPORTANT IS THAT THEY GET THE APPROPRIATE IMMUNIZATIONS, AND I WOULD FOCUS ON PARTICULARLY THREE. ONE IS THE BOOSTER SHOT THAT HAS TETANUS, DIPHTHERIA AND PERTUSSIS. PERTUSSIS, WHOOPING COUGH, AND WE HAVE SEEN A LOT OF CASES OF WHOOPING COUGH IN VERY, VERY YOUNG KIDS BEFORE THEY GET IMMUNIZED BECAUSE THEY'VE BEEN EXPOSED TO OLDER ONES WHO WERE IMMUNIZED BUT THEY LET THE IMMUNIZATIONS LAPSE, THEY HAVEN'T GOTTEN THE BOOSTERS, SO IT'S REALLY IMPORTANT FOR THEM AND FOR THOSE THEY ARE IN CONTACT WITH. MENINGOCOCCAL DISEASE IS FORTUNATELY RELATIVELY RARE, BUT AMONG TEENS, 10% WHO GET IT WILL DIE FROM IT, AND IT'S A TOTALLY PREVENTABLE DISEASE. AND THIRD, HUMAN PAPILLOMA VIRUS IS THE CAUSE OF CERVICAL CANCER. THIS VACCINE, IF EVERY YOUNG GIRL GOT THIS VACCINE IN PRE-TEEN, WE COULD REDUCE THE RATE OF CERVICAL CANCER BY 70%. YOU STILL NEED PAP SMEARS BECAUSE THERE'S THE OTHER 30%, BUT THESE ARE ALL LIFE SAVING VACCINES AND IT'S REALLY IMPORTANT THAT EVERYBODY MAKE SURE THAT THEIR CHILDREN ARE GETTING THEM. THANK YOU. 

DR. MARLENE LUGG: THANK YOU. MY NAME IS MARLENE LUGG, AND I'M CURRENTLY THE CHAIR OF THE LOS ANGELES IMMUNIZATION COALITION. ON BEHALF OF MY BOARD OF DIRECTORS, I WOULD LIKE TO THANK YOU ALL VERY MUCH FOR DRAWING ATTENTION TO AND HELPING US PROMOTE PRE-TEEN VACCINATION WEEK. WE ARE SO FORTUNATE NOWADAYS TO HAVE TWO VACCINES, AMONG ALL THE ONES THAT DR. FIELDING MENTIONED, THEY'RE ALL EXTREMELY IMPORTANT, BUT WE'RE SO FORTUNATE TO HAVE TWO VACCINES WHICH ARE ACTUALLY PREVENTING A LARGE NUMBER OF CANCERS. THE FIRST IS HEPATITIS B, WHICH WORKS VERY WELL AT PREVENTING LIVER CANCER. AND THE SECOND ONE IS THE NEW H.P.V. VACCINE, WHICH, BY PREVENTING HUMAN PAPILLOMA VIRUS INFECTION, PREVENTS THE MAJORITY OF CERVICAL CANCER. AS A MOTHER AND A SOON TO BE GRANDMOTHER, I CAN ONLY SAY WHAT A GREAT GIFT WE CAN GIVE OUR CHILDREN AND GRANDCHILDREN IN MAKING SURE THEY'RE PROPERLY IMMUNIZED AGAINST ALL THE VACCINE-PREVENTABLE DISEASES. AND I WANT TO THANK YOU VERY MUCH FOR THE ROLE YOU ARE PLAYING IN HELPING DO THAT. THANK YOU. [ APPLAUSE ] 

SUP. BURKE, CHAIR: SUPERVISOR KNABE? 

SUP. KNABE: I HAVE NO PRESENTATIONS. 

SUP. BURKE, CHAIR: SUPERVISOR ANTONOVICH? 

SUP. ANTONOVICH: THIS MORNING, WE WANT TO RECOGNIZE AN INDIVIDUAL, TWO INDIVIDUALS WHO HAVE MADE A VERY SIGNIFICANT CONTRIBUTION TO OUR COUNTY OF LOS ANGELES, ONE OF OUR LEADING EDUCATIONAL INSTITUTIONS, THAT CALIFORNIA STATE UNIVERSITY, CSUN, NORTHRIDGE, AND THAT'S DAVID AND JEAN FLEMING. THEY HAVE GENEROUSLY PROVIDED $1 MILLION TOWARDS THE CONSTRUCTION OF A NEW PERFORMING ARTS CENTER. THIS IS ONE OF THE LARGEST FOR CAL STATE NORTHRIDGE PROPOSED 1,700 SEAT, $125 MILLION PERFORMING ARTS CENTER PROJECT. IN RECOGNITION OF THEIR GENEROSITY, THE GRAND STAIRCASE IN THE MAIN LOBBY OF THE PERFORMANCE HALL WILL BE NAMED THE JEAN AND DAVID FLEMING GRAND STAIRCASE. THIS NEW PERFORMANCE ARTS CENTER IS THE CULMINATION OF A 49-YEAR DREAM BY THE CSUN'S FOUNDERS, WHO INTENDED FOR THE CAMPUS TO BE THE CULTURAL AND ECONOMIC HEART OF THE SAN FERNANDO VALLEY. IT'S GOING TO BE THE LARGEST ARTS VENUE IN THE VALLEY AND WILL DRAW RESIDENTS FROM MANY OF OUR ADJOINING COUNTIES AND VALLEYS. DAVID IS AN ATTORNEY WITH THE FIRM LATHAM AND WATKINS, IS A PROMINENT LEADER IN OUR SAN FERNANDO VALLEY IN LOS ANGELES COUNTY. HIS ACTIVITIES HAVE INCLUDED SERVING ON THE CHAIRMAN OF THE BOARD OF ECONOMIC ALLIANCE OF THE SAN FERNANDO VALLEY, DIRECTOR OF THE LOS ANGELES COUNTY METROPOLITAN TRANSIT AUTHORITY, CHAIRMAN OF THE LOS ANGELES AREA CHAMBER OF COMMERCE. HIS WIFE, JEAN, IS A FORMER ACTRESS. SHE IS A MOTION PICTURE PRODUCER AND SCREENWRITER. SHE BEGAN HER CAREER AS A MOTION PICTURE AND TELEVISION ACTRESS AFTER BEING CHOSEN MISS ILLINOIS IN THE MISS AMERICA PAGEANT OF THE 1960S. SHE APPEARED IN SEVERAL MOTION PICTURES AND TELEVISION SHOWS IN THE '60S AND '70S UNDER HER STAGE NAME, JEAN BLAKE. SHE DEVOTES MUCH OF HER TIME NOW TO CHARITY WORK AND CIVIC CAUSES, AS WELL AS HELPING OUR YOUNG PEOPLE GET A FOOTHOLD IN THE FILM INDUSTRY. THE FLEMINGS HAVE BEEN LONG-TIME SUPPORTERS OF CAL STATE NORTHRIDGE, WHERE DAVE HAS SERVED AS A MEMBER OF THE CSUN FOUNDATION BOARD OF DIRECTORS AND ADVISOR OF THE SAN FERNANDO VALLEY ECONOMIC RESEARCH CENTER, AND THE COLLEGE OF BUSINESS AND ECONOMICS. THIS NEW PERFORMING ARTS CENTER IS GOING TO BE LOCATED ON THE SOUTHWEST CORNER OF THE CAMPUS NEAR THE CORNER OF NORDOFF STREET AND LINDLEY AVENUE, AND SERVES AS CULTURAL AND ECONOMIC LANDMARK FOR THE VALLEY. IT INCLUDES SOPHISTICATED FEATURES SUCH AS THE ABILITY TO ACOUSTICALLY TUNE ITS MAIN PERFORMANCE HALL TO FIT PARTICULAR PRESENTATIONS, WHETHER IT BE MUSIC, DRAMA, THEATRE, FILM, OR SPEAKERS, OR DANCE. THE PERFORMANCE HALL WILL ALSO BE LARGE ENOUGH TO ACCOMMODATE FULL SCALE BROADWAY PRODUCTIONS AND OPERAS. SO WE WANT TO THANK YOU BOTH AND A COLLEAGUE, WHO HAS ALSO JOINED IN GIVING CONTRIBUTIONS AS WELL AS I HAVE FOR THIS WONDERFUL PERFORMING ARTS CENTER, SUPERVISOR YAROSLAVSKY WOULD LIKE TO SAY A COUPLE WORDS AT THIS TIME. 

SUP. YAROSLAVSKY: THANK YOU. I JUST WANT TO JOIN IN HONORING THE FLEMINGS, WHO HAVE BEEN REALLY THE PRIVATE SECTOR LEADERS OF THIS CAMPAIGN. THIS IS GOING TO BE A VERY EXCITING VENUE IN THE SAN FERNANDO VALLEY AND FOR THE COUNTY AS A WHOLE, AND I'M VERY PLEASED THAT THE COUNTY MUSIC CENTER HAS DEVELOPED A MEMORANDUM OF UNDERSTANDING FOR THE CAL STATE NORTHRIDGE ON A SHARING PROGRAM, SHARING OUR REPERTOIRE, WHETHER IT'S OPERA OR MUSIC OR DANCE OR THEATRE WITH THE NEW THEATRE THAT'S GOING TO BE AT CAL STATE NORTHRIDGE. IT REALLY IS A PARTNERSHIP WHICH IS THE BASIS UPON WHICH THE COUNTY HAS MADE SEVERAL MILLION DOLLARS WORTH OF INVESTMENT IN THIS PROJECT, A PARTNERSHIP BETWEEN CSUN AND LOS ANGELES COUNTY AND MANY OF OUR VALLEY RESIDENTS WILL NOT HAVE TO DRIVE ALL THE WAY DOWN TO DOWNTOWN LOS ANGELES DURING THE RUSH HOUR TO SEE SOME OF THE FINEST CULTURAL PERFORMANCES THAT YOU CAN FIND ANYWHERE IN THE WORLD. AND THAT'S GOING TO REALLY BE AN ASSET TO THE VALLEY AND TO CSUN IN PARTICULAR. SO DAVID, YOUR LEADERSHIP SETS THE EXAMPLE FOR OTHERS, INCLUDING US, AND I APPRECIATE YOUR GREAT COMMITMENT TO THIS PROJECT, AND WE LOOK FORWARD TO THE RIBBON CUTTING. 

DAVID FLEMING: THANK YOU. THANK YOU, ZEV. THANK YOU, MIKE. WE'RE JUST HAPPY TO HELP IN ANY WAY WE CAN, AND ON BEHALF OF JEAN, THANK YOU VERY MUCH TO THE COUNTY. [ APPLAUSE ] 

SUP. ANTONOVICH: LAST WEEK, EVERYBODY COMPLIMENTED ON THE BEAUTIFUL LITTLE DOG WE HAD GIVEN AWAY. AND THIS ONE LOOKS LIKE A COUSIN. THIS IS PEANUT, WHICH IS A COCKER SPANIEL MIX. BUT IT'S THE SAME COLOR COMBINATION. AND SHE'S 5 MONTHS OLD. ANYWAY, ANYBODY WHO'D LIKE TO ADOPT LITTLE PEANUT, YOU CAN CALL THE NUMBER, (562) 728-4644, OR ANYBODY IN THE AUDIENCE, IF YOU'D LIKE TO ADOPT. ANYBODY OUT THERE? OKAY. THANK YOU. 

SUP. BURKE, CHAIR: EVERYBODY'S GOING TO WANT THAT DOG. ALL RIGHT, STARTING WITH THE FIRST DISTRICT, RIGHT? SUPERVISOR MOLINA, DO YOU HAVE ADJOURNMENTS? IF NOT, I'LL START MY ADJOURNMENTS, AND THEN WE CAN COME BACK TO SUPERVISOR MOLINA WHEN SHE -- IT IS WITH FIRST DISTRICT FIRST, RIGHT? 

CLERK SACHI HAMAI: CORRECT. 

SUP. BURKE, CHAIR: I MOVE THAT WHEN WE ADJOURN TODAY, WE ADJOURN IN MEMORY OF JAMES L. WICKER, THE BROTHER OF L.A. COUNTY PARK & RECREATION CHIEF DEPUTY, JOHN WICKER, WHO RECENTLY PASSED AWAY AT THE AGE OF 59. HE WAS A NAVY VETERAN WHO SERVED DURING THE VIETNAM WAR. HIS MOST CURRENT CAREER FOR OVER 20 YEARS WAS IN THE TRUCKING BUSINESS. HE LEAVES TO CHERISH HIS MEMORY HIS MOTHER BETTY WICKER; TWO BROTHERS, MIKE AND JOHN WICKER; AND CHILDREN, JAMES, CHRISTINE, AND JASON. 

SUP. KNABE: ALL MEMBERS. ALL MEMBERS ON WICKER. 

SUP. BURKE, CHAIR: ALL MEMBERS. IRWIN BUTER WAS A HIGH SCHOOL CLASSMATE OF MINE WHO PASSED AWAY ON JANUARY 7TH. HE PRACTICED LAW IN LOS ANGELES FOR OVER 50 YEARS. HE WAS A DEAN OF THE FAMILY LAW SECTION OF THE COUNTY BAR ASSOCIATION AND A KNOWN CIVIL RIGHTS ACTIVIST. HE LEAVES TO CHERISH HIS MEMORY HIS WIFE, SHIRLEY BUTER; SONS, GLENN AND SCOTT; AND DAUGHTER, LISA. AND DALE HALL, SR., THE FATHER OF L.A. COUNTY PARKS AND RECREATION REGIONAL OPERATION MANAGER, DALE HALL. HE WAS A PROUD VETERAN WHO SERVED IN THE U.S. ARMY. HE PASSED AWAY ON JANUARY 8TH 2008 AT THE AGE OF 82. HE LEAVES TO CHERISH HIS MEMORY HIS WIFE, VERA HALL; SON, DALE; NEPHEWS, JOSEPH KEY AND ROBERT SMITH; AND NIECE, BARBARA CRAWFORD; ALONG WITH A HOST OF FAMILY AND FRIENDS. ALL MEMBERS. AND VINEY B. SMILEY, THE MOTHER OF ACTIVE COMMUNITY MEMBER OTIS "DINO" SMILEY, WHO RECENTLY PASSED AWAY. SHE WAS AN ORIGINAL MEMBER OF THE TROJANS SENIOR CLUB AT WASHINGTON PARK. SHE LEAVES TO CHERISH HER MEMORY HER THREE CHILDREN, ALONG WITH A HOST OF FAMILY AND FRIENDS. AND JOANNE JEFFERSON, A LONG-TIME COUNTY RESIDENT. I GRADUATED FROM COLLEGE WITH HER. HER DAUGHTER IS THE DIRECTOR OF THE AFRICAN AMERICAN MUSEUM AND EXPOSITION PARK. JOANNE WAS A LONG-TIME PERSON INVOLVED IN THE COMMUNITY AND INVOLVED IN MANY THINGS IN TERMS OF THE LEGAL PROFESSION. EVEN THOUGH SHE WAS NOT AN ATTORNEY, SHE WAS ALWAYS VERY, VERY CLOSELY ALIGNED AS A PARALEGAL. I'LL START WITH SOME OF THOSE, SOME OF THE ITEMS THAT WE'RE HOLDING AND THEN -- OH, SUPERVISOR MOLINA IS HERE NOW. YOUR ADJOURNMENTS? 

SUP. MOLINA: I HAVE TWO ADJOURNMENTS. I'D LIKE TO ASK THAT WE ADJOURN THIS MORNING -- I GUESS THAT'S ON -- IN THE MEMORY OF LONG-TIME SANTA FE RESIDENT JOSE D. VELASCO, SR. MR. VELASCO FOUGHT FOR OUR COUNTRY IN WORLD WAR II. HE WAS A PROUD VETERAN OF THE UNITED STATES ARMY. WE WANT TO EXTEND OUR HEARTFELT CONDOLENCES TO HIS ENTIRE FAMILY. I ALSO WOULD LIKE TO ASK THAT WE ADJOURN THIS MORNING IN THE MEMORY OF LONG-TIME COUNTY RESIDENT JORGE R. TAMAYO. WE WANT TO EXTEND OUR DEEPEST CONDOLENCES TO HIS FAMILY AS WELL. THOSE ARE MY ADJOURNMENTS. AND I DON'T HAVE ANY ITEMS THAT I'M HOLDING. 

SUP. BURKE, CHAIR: I'LL CALL UP S-1. IT WAS HELD BY A MEMBER OF THE PUBLIC. OKAY. AND DR. CLAVREUL, DO YOU MIND ADDRESSING THAT AND 53-A? AND ALSO 15, I BELIEVE YOU'RE HOLDING. 

DR. GENEVIEVE CLAVREUL: GOOD MORNING, BOARD OF SUPERVISORS. DR. GENEVIEVE CLAVREUL. ON S-1, YOU KNOW, IT'S KIND OF ABSURD THAT THE BUDGET FOR THE DEPARTMENT OF HEALTH HAS BEEN PUSHED MORE THAN SIX MONTHS NOW. IT'S VERY DIFFICULT TO SEE WHAT'S GOING ON. AND WE HAVE MORE AND MORE PEOPLE NOW WORKING FOR THE DEPARTMENT OF HEALTH. AND, LIKE TODAY, I WAS LOOKING MANY ITEM, I'VE BEEN REFERRED BACK FROM THE C.E.O., FROM THE DEPARTMENT OF HEALTH. YOU KNOW, THE MORE PEOPLE WE HAVE, THE LESS INFORMATION WE GET. THAT'S VERY UNPLEASANT. ON ITEM 13, WHEN I SEE THAT -- 

SUP. BURKE, CHAIR: 15. 

DR. GENEVIEVE CLAVREUL: OH, 15. I'M SORRY. 15 IS ABOUT THE CONTRACT FOR H.M.A. AND AGAIN, WE'RE HAVING A COMPANY AND WE ARE BEING TOLD CONSISTENTLY THAT THERE WILL BE NO RETROACTIVE PAYMENT. AGAIN, IS THE RETROACTIVE PAYMENT IN THAT. YOU KNOW, IT DOESN'T MAKE ANY SENSE, YOU KNOW, SO ITS PROMISES HAVE NO VALUE. AND AGAIN, IT'S A COMPANY WHICH HAS BEEN SELECTED WITHOUT ANY CONTRACT OPPORTUNITY POSTED ON THE WEB. AND I DON'T SEE WHAT THEY'RE DOING IS EXCEPTIONAL, ESPECIALLY WHEN YOU LOOK AT WHAT'S GOING ON IN THE M.A.C.C. WHEN YOU COMPARE THE RATE OF THE MONTHLY GOAL AND WHAT YOU HAVE ACTUALLY ACCOMPLISHED, IN ALL THE SECTION, WE HAVE MUCH LESS PATIENT, MUCH LESS VISIT. SPECIFICALLY WHEN IT COMES TO GENERAL MEDICINE, WOMAN HEALTH AND PEDIATRICS. BUT ONE THING IS AMAZING. IN X-RAY, WE HAVE OVER 2,000 -- 1,000 MORE VISITS THAN EXPECTED. YOU KNOW, WE HAVE LESS VISITS ANY PLACE ELSE, BUT RADIOLOGY IS TWICE THE AMOUNT. SOMETHING WRONG IN THAT PICTURE. IT SHOULD BE MUCH LESS. OR WE HAVE PEOPLE COMING FROM THE STREETS, COME GET MY X-RAY, YOU KNOW. THAT'S QUITE INAPPROPRIATE. I WOULD LIKE FOR YOU TO LOOK AT THAT. 

SUP. BURKE, CHAIR: ALL RIGHT. ON S-1, THAT WILL BE -- 

DR. GENEVIEVE CLAVREUL: I HAVE ANOTHER ONE. 

SUP. BURKE, CHAIR: YOU HAVE 53 ALSO, 53-A? 

DR. GENEVIEVE CLAVREUL: OH YEAH. ABOUT THE BUNDLING OF CONTRACTS, THAT GOES VERY MUCH TOWARD THE SAME LINE. 

SUP. BURKE, CHAIR: STUDY. 

DR. GENEVIEVE CLAVREUL: ON BUNDLING OF THE CONTRACTS, ISN'T IT ABOUT? YOU KNOW, AND I THINK IN THE COUNTY WE DO A TON OF THAT. I THINK, YES, IT WOULD BE VERY HELPFUL, AND I COMPLIMENT SUPERVISOR ANTONOVICH TO BRING IT TO THE LIGHT. I MEAN, IT'S BEING DONE CONSISTENTLY, ESPECIALLY WHEN IT COMES TO H.I.V. AND A.I.D.S., IF MULTIPLE CONTRACT WERE BUNDLED TOGETHER, SO IT'S THE SAME PEOPLE ALL THE TIME WHO ARE GETTING THE CONTRACT, AND I THINK IT'S TIME TO LOOK AT IT. THANK YOU. 

SUP. BURKE, CHAIR: ALL RIGHT. THANK YOU. ON S-1 THAT IS, WITHOUT OBJECTION, IT'S CONTINUED TO FEBRUARY 19TH. ON 15, MOVED BY MOLINA, SECONDED BY YAROSLAVSKY. WITHOUT OBJECTION, SO ORDERED. ON 53-A, MOVED BY ANTONOVICH, SECONDED BY KNABE. WITHOUT OBJECTION, SO ORDERED. ITEM 13, 18, 26 AND 32, ARE THOSE ALL BEING HELD BY THE SAME PERSON? 

CLERK SACHI HAMAI: CORRECT, YES. 

SUP. BURKE, CHAIR: OKAY. MR. SACHS, WOULD YOU COME UP? YOU KNOW, DR. GENEVIEVE CLAVREUL, DID YOU ALSO SPEAK ON 13 ALREADY? MR. SACHS, WOULD YOU PLEASE COME FORWARD? PARDON ME? DO YOU WANT TO COME UP AND SPEAK ON 13 WHILE HE'S COMING UP, AND THEN... AND THEN HE'LL BE COMING FORWARD. HE WANTED TO SPEAK ON THAT ALSO. 

DR. GENEVIEVE CLAVREUL: OKAY. ON ITEM 13, THE INCREASED SALARY FOR THE DISTRICT ATTORNEY. I'M NOT SURPRISED. YOU KNOW, THE LAST YEAR, NUMEROUS BROWN VIOLATION ARE TRUE OF THE BOARD, AND THE D.A. CHOOSE NOT TO, YOU KNOW, PURSUE. YOU KNOW, I'M SURE THAT'S A REWARD. AND I'M SEEING IT AS A REWARD. I THINK THAT IT SHOULD BE A BALANCE ON HOW THE BUDGET AND THE PAY SCALE OF THE A.D.A., I MEAN THE DISTRICT ATTORNEY, IS SET. BECAUSE THE WAY IT'S SET NOW, IF HE PUNISH YOU FOR YOUR MISBEHAVIOR, YOU WILL PENALIZE HIM. AND THAT'S WHY, YOU KNOW, WE STILL HAVE NOT SEEN THE TAPE WHO LED TO THE CLOSURE OF THE TRAUMA CENTER FOR KING/DREW. AND IT HAS BEEN YEARS. SUPERVISOR YAROSLAVSKY VIOLATED THE BROWN ACT RIGHT AND LEFT LAST YEAR. I DOCUMENTED IT. EVEN AT TIME, MR. COOLEY AGREED THAT IT WAS A VIOLATION, BUT NOTHING WAS EVER DONE. THERE'S SOMETHING WRONG IN THAT PICTURE. THANK YOU. I SEE ALSO WE NEW CHAIRS, WE HAVE NEW EQUIPMENT. WE'RE DOING WELL WITH THE PEOPLE'S MONEY HERE IN THE COUNTY. 

SUP. BURKE, CHAIR: WE CAN HEAR YOU BETTER, TOO, WITH THE NEW MICROPHONE. 

DR. GENEVIEVE CLAVREUL: BUT YOU DON'T LISTEN. 

SUP. BURKE, CHAIR: OH, WE'RE LISTENING. MR. SACHS. 

ARNOLD SACHS: GOOD MORNING. THANK YOU. 

SUP. BURKE, CHAIR: DO YOU WANT TO START WITH 13 AND THEN GO TO 18, 26 AND 32? 

ARNOLD SACHS: I'M FAIRLY EASY. I CAN DO THAT. THANK YOU. ARNOLD SACHS. THE ITEM NUMBER 13 IS REGARDING PAY INCREASES. IT'S JUST AMAZING THAT YOU'RE HAVING THIS ITEM ON YOUR AGENDA AND THEN ON YOUR SUPPLEMENTAL AGENDA, YOU HAVE ITEM 53-B, A RECOMMENDATION THAT'S SUBMITTED BY SUPERVISOR ANTONOVICH, DIRECT THE CHIEF EXECUTIVE OFFICER TO ANALYZE THE IMPACT OF THE GOVERNOR SCHWARZENEGGER'S BUDGET ON THE COUNTY AND REPORT BACK TO THE BOARD. SO I IMAGINE HE WANTS TO ANALYZE THE BUDGET CUTS THAT THE GOVERNOR IS PROPOSING AND REPORT BACK TO THE COUNTY BOARD. AND THIS ITEM, YOU'RE LOOKING TO RAISE SALARIES. I'D ALSO LIKE TO POINT OUT THAT THERE IS AN ARTICLE IN THE PRESS-TELEGRAM REGARDING SALARIES IN THE COUNTY. AND IT NAMES THE SALARY FOR THE C.E.O., BILL FUJIOKA, AT $310,000, UP 29% OVER THE LAST TWO YEARS. NEVER MIND 29% OVER LAST TWO YEARS, DIDN'T THE PREVIOUS C.E.O. HAVE A SALARY OF $300,000, AND HE RETIRED IN JUNE. AND IN SIX MONTHS, THE SALARY'S ALREADY GONE UP OVER $10,000? THAT'S A NICE INCREASE. MOST PEOPLE, AFTER SIX MONTHS, GET A QUARTER RAISE. THAT'S JUST REALLY TOUGH TO HAVE TO FIND OUT. NEXT ITEM YOU'D LIKE ME TO TALK ABOUT, MA'AM? 

SUP. BURKE, CHAIR: 18. 

ARNOLD SACHS: 18 REGARDS SOME EDUCATION AND TRAINING FOR HEALTHCARE WORKERS. I'D LIKE TO KNOW THAT THIS IS JUST FOR NEW HEALTHCARE WORKERS AND NOT AS WAS IDENTIFIED FROM THE MARTIN LUTHER KING HOSPITAL FIASCO WHEN THEY DID THE EVALUATION AND FOUND THAT 60% OF THE STAFF WAS NOT UP TO THE STANDARDS THAT ARE REQUIRED BY THE HOSPITAL AND HAD TO GO BACK FOR RETRAINING AND RETRAINING BEFORE THEY COULD EVEN BE TRANSFERRED INSTEAD OF BEING DISCIPLINED FOR NOT REACHING THE STANDARDS THAT ARE REQUIRED. SO THAT THIS EDUCATION AND TRAINING SHOULD JUST BE FOR NEW HEALTH EMPLOYEES TO MAKE SURE THAT THEY'RE UP TO PAR FOR THE STANDARDS SET BY THE COUNTY HEALTH DEPARTMENT. THANK YOU. 

SUP. BURKE, CHAIR: 26. AND 32. YOU MAY WANT TO PUT THEM BOTH TOGETHER. 

ARNOLD SACHS: HERE AGAIN, OFFERING INDEPENDENT CONTRACTS TO ALL, FOR ALL THESE DIFFERENT SERVICES. I'M WONDERING, HAS ANYBODY CHECKED ABOUT AGAIN AN INDEPENDENT CONTRACT FOR RUNNING THE COUNTY JAIL SYSTEM AND SO THAT THE SHERIFFS COULD BE REMOVED TO PUT OUT IN THE UNINCORPORATED AREA. AND ALONG THAT LINES, WHAT'S THE STATUS OF THE SHERIFF'S BID FOR THE M.T.A. CONTRACT? THANK YOU. 

SUP. BURKE, CHAIR: ALL RIGHT. ON 13, MOVED BY KNABE, SECONDED BY YAROSLAVSKY. WITHOUT OBJECTION, SO ORDERED. ON 18 -- 

CLERK SACHI HAMAI: AND THE RELATED ITEM 52. 

SUP. BURKE, CHAIR: AND 52. 

CLERK SACHI HAMAI: THANK YOU. 

SUP. BURKE, CHAIR: ON 18, MOVED BY ANTONOVICH, SECONDED BY YAROSLAVSKY. ON 26, MOVED BY KNABE, SECONDED BY MOLINA. WITHOUT OBJECTION, SO ORDERED. AND ON 32, MOVED BY MOLINA, SECONDED BY YAROSLAVSKY. WITHOUT OBJECTION, SO ORDERED. THANK YOU VERY MUCH. 

ARNOLD SACHS: EXCUSE ME, MA'AM. I DIDN'T SPEAK ON 32. 

SUP. BURKE, CHAIR: OKAY. WITHOUT OBJECTION, WE'LL MOVE TO RECONSIDER. 

ARNOLD SACHS: THANK YOU. ITEM 32 IS, ALTHOUGH IT'S A SMALL CONTRACT, ONLY $417,000, THIS AGAIN IS A PROGRAM, I BELIEVE THAT THE DEPARTMENT CAME BEFORE THE COUNTY BOARD OF SUPERVISORS LAST YEAR, TOWARDS THE END OF THE YEAR REQUESTING A BUDGET INCREASE FOR SEVERAL HUNDRED MILLION DOLLARS DUE TO COST INCREASES REGARDING THE CONSTRUCTION AT L.A.C./U.S.C. AND I BELIEVE THEY WERE ADMONISHED FOR NOT, NOT COME BEFORE THE BOARD AGAIN AND ASK FOR MORE MONEY. I BELIEVE THAT HAPPENED. I'M ALMOST POSITIVE IT HAPPENED BECAUSE I WAS AT THE MEETING HERE. AND YET HERE THEY ARE COMING BEFORE THE BOARD ASKING FOR ANOTHER $417,000. I GUESS SO MUCH FOR THE ADMONISHMENT. THANK YOU FOR YOUR TIME. 

SUP. BURKE, CHAIR: ALL RIGHT. ON -- 

CLERK SACHI HAMAI: 32. 

SUP. BURKE, CHAIR: 52? 32. MOVED BY MOLINA, SECONDED BY KNABE. WITHOUT OBJECTION, SO ORDERED. ALL RIGHT. SUPERVISOR KNABE? OH, I'M SORRY. SUPERVISOR YAROSLAVSKY. FOR YOUR ADJOURNMENTS. ON CS-1, WAS THERE A MEMBER OF THE PUBLIC, WHO WAS THAT? 

SUP. YAROSLAVSKY: OKAY. MADAM CHAIR, I HAVE SEVERAL ADJOURNING MOTIONS. FIRST I'D ASK THAT WE ADJOURN IN THE MEMORY OF MAX SASS, LONG-TIME RESIDENT OF THE OF OUR DISTRICT, AND CO-FOUNDER OF THE BURBANK SURPLUS AND WESTERN WEAR STORE, WHO RECENTLY PASSED AWAY AT THE AGE OF 91. HE IS SURVIVED BY HIS WIFE, PEARL SASS; HIS CHILDREN, STEVE SASS, A FORMER MEMBER OF MY STAFF IN THE CITY OF LOS ANGELES; LAWRENCE SASS AND STACEY SASS. I ALSO ASK THAT WE ADJOURN IN THE MEMORY OF JUDITH RUDERMAN, FRIEND OF OUR FAMILY AND A VERY ACTIVE MEMBER OF THE WESTWOOD AND BROADER COMMUNITY, PASSED AWAY AFTER A LONG BATTLE WITH CANCER, PASSED AWAY LAST WEEK. SHE IS SURVIVED BY HER HUSBAND, DAVID RUDERMAN AND THEIR THREE CHILDREN, BRADLEY, MELISSA, AND MATTHEW. ALSO A BROTHER, ANTHONY BROWN. I WANT TO ASK THAT WE ADJOURN IN THE MEMORY OF JOHNNY GRANT. I THINK ALL MEMBERS WOULD LIKE TO JOIN ON THAT. JOHNNY WAS AN INTERNATIONALLY KNOWN HONORARY MAYOR OF HOLLYWOOD WHO RECENTLY PASSED AWAY AT THE AGE OF 84. HE BEGAN HIS CAREER IN THE ENTERTAINMENT INDUSTRY AS A CUB RADIO REPORTER IN 1939. THROUGH THE YEARS, HE BECAME KNOWN AS HOLLYWOOD'S HOST, SERVING AS EMCEE ON QUIZ SHOWS AND TALK PROGRAMS, IN BIT PARTS ON TELEVISION AND IN THE MOVIES, AND FINALLY FOR MANY YEARS AS THE COMMUNITY'S BIGGEST CHEERLEADER ON U.S.O. TOURS AND AT COUNTLESS COMMUNITY EVENTS THROUGHOUT LOS ANGELES. HE IS SURVIVED BY HIS MANY FRIENDS AND COLLEAGUES IN THE ENTERTAINMENT COMMUNITY AND AROUND THE WORLD. I'LL JUST SAY THAT FIRST TIME I EVER HEARD OF JOHNNY GRANT, HE WAS A DEEJAY ON KMPC RADIO WHEN I WAS IN SCHOOL. HE HAD THAT MORNING SLOT, 6:00 TO 10:00 A.M., IF MY MEMORY SERVES ME CORRECTLY. AND WE ALWAYS GOT A LAUGH, BECAUSE I USED TO DELIVER NEWSPAPERS FOR THE HOLLYWOOD CITIZEN NEWS AND HE'S JUST ABOUT THE ONLY PERSON ALIVE WHO REMEMBERS THE HOLLYWOOD CITIZEN NEWS. HE WAS JUST A WONDERFUL, WONDERFUL HUMAN BEING AND ALWAYS POSITIVE, ALWAYS WITH A SMILE ON HIS FACE. THERE'S NOTHING THAT HE TACKLED THAT HE COULDN'T SUCCESSFULLY BRING TO CONCLUSION, AND HE PASSED AWAY IN HIS APARTMENT AT THE PENTHOUSE OF THE HOLLYWOOD ROOSEVELT HOTEL, WHICH IS TOTALLY APPROPRIATE. HE'LL BE A GREAT LOSS TO OUR COMMUNITY. DINESH MANOCHA PASSED AWAY AFTER A LONG ILLNESS. SHE IS SURVIVED BY HER SON, ARVIND MANOCHA, WHO IS THE VICE PRESIDENT AND GENERAL MANAGER OF THE HOLLYWOOD BOWL AND PRESENTATIONS FOR THE LOS ANGELES PHILHARMONIC ASSOCIATION. SHE'S ALSO SURVIVED BY OTHER FAMILY MEMBERS, SO I'D LIKE TO ASK THAT WE ADJOURN IN HER MEMORY. AND LASTLY, I WANT TO ASK THAT WE ADJOURN IN THE MEMORY OF SAM FISHER, A LONG-TIME RESIDENT OF THE OF LOS ANGELES, WHO PASSED AWAY AT THE AGE OF 50, FOLLOWING A LENGTHY ILLNESS. HE WILL BE REMEMBERED FOR HIS KIND AND GENTLE PERSONALITY AND HIS INTENSE LOVE OF LIFE, FAMILY AND FRIENDS, ANIMALS, NATURE AND FOOD. HE IS SURVIVED BY HIS SISTER, KERI HAUSNER, WHO'S THE PRESIDENT OF TEMPLE ISRAEL OF HOLLYWOOD, AND OTHER FAMILY MEMBERS AND MANY FRIENDS. THOSE ARE MY ADJOURNING MOTIONS. 

SUP. BURKE, CHAIR: SO ORDERED. 

CLERK SACHI HAMAI: MADAM CHAIR, COULD WE GO BACK TO ITEM 32 AND ASK FOR RECONSIDERATION? ON THIS ITEM, THE CHIEF EXECUTIVE OFFICER HAD REQUESTED A CONTINUANCE OF -- 

SUP. YAROSLAVSKY: I'LL MOVE RECONSIDERATION. 

CLERK SACHI HAMAI: -- TWO WEEKS. 

SUP. BURKE, CHAIR: ALL RIGHT. WITHOUT OBJECTION, IT'S -- ITEM IS RECONSIDERED AND CONTINUED FOR TWO WEEKS. 

CLERK SACHI HAMAI: THANK YOU. 

SUP. BURKE, CHAIR: SO ORDERED. ARE YOU CALLING UP ANY ITEMS? 

SUP. YAROSLAVSKY: I DON'T THINK I AM. 

SUP. BURKE, CHAIR: OKAY. SUPERVISOR KNABE. 

SUP. KNABE: YES, MADAM CHAIR, MEMBERS OF THE BOARD, I SEE ZEV MENTIONED, ALL MEMBERS ON JOHNNY GRANT. I THINK WE ALL HAVE OUR JOHNNY GRANT STORIES. AND KNOWN HIM FOR SO LONG AND SHARING PODIUMS WITH HIM, WE JUST HONORED HIM LAST YEAR AT COMMUNITY SENIOR SERVICES. AND WE EACH HAVE OUR OWN STORIES. BUT I'LL ALWAYS REMEMBER ANY EVENT HE EMCEED AT THE BEVERLY HILTON. IF YOU REMEMBER, HE ALWAYS TOOK THE MICROPHONE TO THE BACK OF THE ROOM AND WOULD NOT ADJOURN THE CROWD UNTIL HE WAS OUT IN THE LOBBY ABLE TO GET HIS CAR, THE FIRST ONE. HE ALWAYS DID THAT OUT THERE, BECAUSE HE ALWAYS HATED FIGHTING THOSE CROWDS, BUT HE WAS A GREAT MAN, GREAT AMERICAN, AND MEANT A LOT TO OUR TROOPS AS WELL, TOO. ALSO THAT WE ADJOURN IN THE MEMORY OF LORETTA ROMASH, A RESIDENT OF CERRITOS, A LONG-TIME MEMBER OF THE COMMUNITY THERE, BOTH IN THE ARTESIA, CERRITOS AREA, SHE AND HER HUSBAND JOE. SHE WAS VERY ACTIVE IN COMMUNITY GROUPS, SENIOR GROUPS. SHE IS SURVIVED BY HER CHILDREN, JOYCE AND JAMES; 11 GRANDCHILDREN, AND 13 GREAT GRANDCHILDREN. ALSO THAT WE ADJOURN IN THE MEMORY OF PAT KELEMEN, A LONG-TIME RESIDENT OF ARTESIA. BORN IN LOS ANGELES AND WAS AN ACTIVE VOLUNTEER AT CHURCH SCHOOL. SHE WAS THE MOTHER OF FORMER MAYOR AND CITY COUNCIL MEMBER TIM KELEMEN IN THE CITY OF ARTESIA. SHE IS SURVIVED BY HER HUSBAND OF 56 YEARS, ERNEST; NINE CHILDREN, 26 GRANDCHILDREN, AND 8 GREAT-GRANDCHILDREN; AND TWO SISTERS, HELEN AND JO ANNE. ALSO THAT WE ADJOURN IN THE MEMORY OF CHERYL ANN SCHIPSKE-HIGLEY, PASSED AWAY JANUARY 8TH AFTER A SHORT ILLNESS. SHE WAS BORN IN ARTESIA, RAISED IN BUENA PARK. SHE MARRIED SERGEANT TOM HIGLEY IN 1981, AND THEY WERE PROUD PARENTS OF FOUR CHILDREN. SHE IS SURVIVED BY HER CHILDREN, TOM, TIM, ERIN, AND MEGAN; GRANDCHILDREN, RYAN AND HUNTER; AND SIBLINGS, HER SISTER GERRIE, WHO IS A MEMBER OF THE CITY COUNCIL IN LONG BEACH, AND NORMAN. ALSO THAT WE ADJOURN IN THE MEMORY OF BOB WOEHRMANN. BOB SERVED IN THE MERCHANT MARINES DURING WORLD WAR II AND WAS ON ACTIVE DUTY DURING THE KOREAN WAR. HE RETIRED AS A LIEUTENANT COLONEL AFTER 36 YEARS OF SERVICE. BOB WAS AN ASSISTANT CITY MANAGER, ACTUALLY SERVED IN THE CITY GOVERNMENT THERE AT WHITTIER, BUT THEN FOLLOWED BY FOUR YEARS ON THE CITY COUNCIL, AS WELL AS HIS MANY LEADERSHIP ACTIVITIES DURING THE '87 EARTHQUAKE. HE IS SURVIVED BY HIS WIFE, JOAN AND THEIR DAUGHTER, DENISE. BOB WAS A GREAT GUY. ALSO THAT WE ADJOURN IN THE MEMORY OF MARY TOVAR, RESIDENT OF HAWAIIAN GARDENS. SHE IS SURVIVED BY HER FIVE CHILDREN, EDWARD, PAUL, LINDA, DONALD, AND MICHAEL; 13 GRANDCHILDREN, ONE GREAT GRANDDAUGHTER, AND THREE SIBLINGS. ALSO THAT WE ADJOURN IN THE MEMORY OF BOB POPESCU, FOUNDER OF THE POPULAR JAZZ CLUB, THE CATALINA BAR AND GRILL, PASSED AWAY AT THE AGE OF 77. HE WAS BORN IN ROMANIA, HE HAD A DEGREE IN ELECTRICAL ENGINEERING. HE DEFECTED TO THE UNITED STATES IN 1969 AND BECAME A CITIZEN. HE MARRIED HIS WIFE, CATALINA, AND THEY OPENED THAT CLUB IN HOLLYWOOD WITH A LOT OF HARD WORK IN 1986. HE HAD MANY GREAT ARTISTS THERE, HAD MANY CHARITABLE EVENTS THERE. HE IS SURVIVED BY HIS WIFE CATALINA; SON, MICHAEL; GRANDSON MICHAEL, WHO LIVES IN ROMANIA; AND TWO SISTERS. ALSO THAT WE ADJOURN IN THE MEMORY OF PHILIP MUELRATH, A LONG-TIME RESIDENT OF SOUTH BAY, PASSED AWAY AT THE AGE OF 91. HE IS SURVIVED BY HIS WIFE OF 49 YEARS, BARBARA; HIS BROTHER JOHN; MANY NIECES AND NEPHEWS. ALSO THAT WE ADJOURN IN THE MEMORY OF BRITTANY REED. SHE WAS BORN IN HARBOR CITY, LIVED IN REDONDO BEACH. HER 17 SHORT YEARS OF LIFE. SHE PASSED AWAY JANUARY 3RD AFTER A 9-MONTH BATTLE WITH LEUKEMIA. SHE WAS A STUDENT AT REDONDO UNION HIGH SCHOOL, LOVED SPENDING TIME WITH HER FAMILY AND FRIENDS. SHE IS SURVIVED BY HER FATHER, ROBERT; MOTHER KANDICE; BROTHERS, MASON AND NOAH. ALSO ADJOURN IN THE MEMORY OF JAMES WICKER, JOHN'S BROTHER. ALSO THAT WE ADJOURN IN MEMORY OF HARRY RILLING, WHO PASSED AWAY AT THE AGE OF 80 IN LONG BEACH. HE HAD HIS OWN FISHING TOOL COMPANY THERE IN SIGNAL HILL. HE WAS THE FOUNDER OF THE SIGNAL HILL HONORARY POLICE OFFICER'S ASSOCIATION AND ITS FIRST PRESIDENT. HE WAS A MEMBER OF THE LONG BEACH PETROLEUM CLUB, AND NOMADS. HE LOVED GOLF AND IS SURVIVED BY HIS SON, MICHAEL; THREE GRANDDAUGHTERS, ELIZABETH, AMY, AND JESSICA; SISTER, BARBARA; AND EXTENDED FAMILY. ALSO THAT WE ADJOURN IN THE MEMORY OF CAROLYN NISSEN RATHBURN, WHO PASSED AWAY JANUARY 8TH AFTER A LONG BATTLE WITH CANCER. AND SHE GRADUATED FROM WILSON HIGH SCHOOL AND MILLS COLLEGE. SHE TRAVELED THE WORLD. SHE WAS A WATER COLOR ARTIST, HORSEWOMAN, VOLUNTEER. SHE ENJOYED HER NEW FRIENDS THAT SHE MET THROUGH HER PARENTS, HER MOTHER AT THE ALAMITOS BAY. SHE IS SURVIVED BY HER MOTHER, ELEANOR; BROTHER, EDWARD; NEPHEW, JEFFREY; AUNT, LAURA; AND MANY COUSINS. THOSE ARE MY ADJOURNMENTS. 

SUP. BURKE, CHAIR: SO ORDERED. AND NOW SUPERVISOR YAROSLAVSKY FOR JUST ONE SECOND FOR A PRESENTATION. 

SUP. YAROSLAVSKY: SPECIAL PRESENTATION. 

SUP. BURKE, CHAIR: THAT HE DIDN'T DO AT THE TIME. 

SUP. YAROSLAVSKY: I APPRECIATE IT, DON. I FORGOT TO DO THIS. WE DIDN'T AGENDIZE THIS FOR OBVIOUS REASON. BUT I WANTED TO CALL UP SHIRLEY JUAREZ TO JOIN ME FOR A SECOND. I THINK WE CALLED YOU DOWN, SAID TAKE MY MAIL BACK UP, AND I THINK I'M ALMOST READY TO HAVE YOU TAKE IT BACK UP, BUT THAT'S NOT THE REAL REASON WE GOT YOU DOWN HERE. SHIRLEY JUAREZ HAS BEEN A SECRETARY FOR THE COUNTY OF LOS ANGELES, AN EMPLOYEE OF THE COUNTY OF LOS ANGELES FOR OVER 40 YEARS. WE ACTUALLY HAD THIS SITTING AROUND FOR ALMOST A YEAR NOW. SO HOW MANY, IS IT ALMOST 41 NOW? TRUTH IS THAT YOUR BOSS, MY CHIEF OF STAFF, MISPLACED THIS AND FOUND IT WHEN SHE WAS CLEANING HER OFFICE. BUT BETTER LATE THAN NEVER. GOOD THING YOU DIDN'T RETIRE LAST YEAR. SHIRLEY HAS BEEN A SECRETARY IN OUR OFFICE SINCE I GOT HERE AND WAS A SECRETARY FOR MY PREDECESSOR, SUPERVISOR ED EDELMAN, IN HIS OFFICE FOR A NUMBER OF YEARS. THERE IS NO HARDER WORKER AND NO MORE PLEASANT PERSONALITY IN OUR OFFICE EVERY DAY. A VERY DEPENDABLE, MORE THAN DEFENDABLE, SHE'S THERE BEFORE WE ALL GET THERE AND SHE'S THERE LONG AFTER WE'RE ALL GONE DOING OUR THINGS. AND I WANTED TO TAKE THIS OPPORTUNITY TO PRESENT YOU WITH WHAT YOU GET FOR 40 YEARS OF SERVICE. AND THIS IS ACTUALLY PRETTY NICE. THIS IS BETTER THAN WHAT WE USED TO DO AT THE CITY, BILL. THIS IS A BEAUTIFUL BRACELET WHICH -- COME OVER HERE SO WE CAN GET THIS PHOTO OP, SHIRLEY. AND I WANT TO TELL YOU, ON BEHALF OF OUR OFFICE AND THE ENTIRE COUNTY FAMILY, ANYBODY WHO ENJOYS WORK AND WHO HAS ENJOYED IT FOR AS LONG AS SHIRLEY HAS, AND IS STILL SO YOUNG, SHE STILL HAS ANOTHER 20 YEARS TO GO, THAT SHE DESERVES TO BE RECOGNIZED. AND WE WANTED TO TAKE THIS OPPORTUNITY TO RECOGNIZE YOU. CONGRATULATIONS. [ APPLAUSE ] 

SUP. YAROSLAVSKY: YOU KNOW WHAT THAT MEANS, THAT MEANS WHEN SHE CAME TO WORK FOR THE COUNTY, I WAS STILL RUNNING CROSS COUNTRY AT FAIRFAX HIGH SCHOOL. 

SUP. KNABE: SHE PROBABLY WOULD HAVE WISHED YOU HAD YOUR MICROPHONE ON MUTE. 

SUP. YAROSLAVSKY: SHE WAS A CHILD EMPLOYEE, ABSOLUTELY. THANK YOU. 

SUP. KNABE: MADAM CHAIR, I HELD ITEM NUMBER 9. I HAD SOME QUESTIONS OF COUNSEL IN REGARD TO THIS ORDINANCE CHANGE. 

RAY FORTNER, COUNSEL: MADAM CHAIR, I'M GOING TO ASK RICK WEISS IF HE WOULD TAKE THE CHAIR HERE. 

SUP. KNABE: RICK, ON THIS, WE'VE RECEIVED A LETTER FROM THE CITY OF DIAMOND BAR, AND I UNDERSTAND SUPERVISOR ANTONOVICH RECEIVED A LETTER FROM THE CITY OF SAN CLARITA BASICALLY ASKING THE SAME QUESTIONS. BUT THEY RAISED A NUMBER OF ISSUES. ONE, THE AMENDMENT TO SECTION B.5, WHICH ALLOWS THE COUNTY TO OPPOSE ANNEXATIONS BASED ON LAND USE. AND THEY INDICATE THAT THIS VIOLATES THE CALIFORNIA GOVERNMENT CODE. IS THAT YEA OR NAY, OR WHAT'S YOUR OPINION? WHAT'S THE COUNTY'S OPINION? 

RICHARD WEISS: MADAM CHAIR, SUPERVISOR KNABE, NO, WE DON'T AGREE WITH THAT. WE HAVE REVIEWED THE LETTERS FROM BOTH DIAMOND BAR AND SAN CLARITA AND WE DO NOT AGREE THAT THE PROPOSED POLICY VIOLATES STATE LAW IN ANY WAY. IN FACT, WE BELIEVE THAT THE POLICY JUST SETS OUT MORE FORMALLY WHAT THE COUNTY ALREADY HAS THE RIGHT AND OBLIGATION TO DO, AND THAT IS TO CONSIDER THE IMPACTS OF ANNEXATIONS ON THE UNINCORPORATED AREA IN APPROPRIATE AREAS. 

SUP. KNABE: WHAT ABOUT -- I MEAN, HAVEN'T WE HAD THE ABILITY IN THE PAST TO OPPOSE ANNEXATION ON LAND USE? SO WHY DO WE NEED THE AMENDMENT? 

RICHARD WEISS: WELL, I BELIEVE THE THOUGHT WAS THAT THE POLICY, HAVING IT IN WRITING PROVIDES NOTICE TO THE CITIES AS TO THE ISSUES THAT THE COUNTY INTENDS TO DISCUSS WITH CITIES WHEN THEY BRING ANNEXATION OR, FOR THAT MATTER, PRIVATE APPLICANTS. SO IT CERTAINLY IS SOMETHING WE COULD DO ANYWAY. BUT THERE IS A BENEFIT OF HAVING IT IN WRITING SO CITIES KNOW WHAT THEY'RE GOING TO BE DISCUSSING. 

SUP. KNABE: WHAT IS THE PROCESS IF THE COUNTY WANTS TO FORMALLY OPPOSE AN ANNEXATION? 

RICHARD WEISS: STAFF WOULD BRING AN ITEM TO YOUR BOARD AND ASK YOUR BOARD TO TAKE A FORMAL POSITION. THIS POLICY DOES NOT AUTHORIZE STAFF TO TAKE AN INDEPENDENT POSITION ON ANNEXATIONS. SO NOTHING WOULD HAPPEN WITHOUT YOUR BOARD HAVING THE OPPORTUNITY TO WEIGH IN AND DECIDE WHETHER OR NOT THEY AGREED. 

SUP. KNABE: IN REGARDS TO THE ISSUE OF STATE LEGISLATION, WHICH WOULD ADDRESS THE TRANSFER OF RHNA UNITS, SHOULDN'T THE -- WOULDN'T WE WANT THE COUNTY'S POLICY TO MIRROR THE STATE? 

RICHARD WEISS: BOTH CITIES' LETTERS MAKE REFERENCE TO A PROPOSED LAW. IN FACT, THAT LAW HAS ALREADY BEEN ADOPTED AND HAS BECOME EFFECTIVE ON JANUARY 1ST OF THIS YEAR. THAT LAW SIMPLY INDICATES THAT IN AN ANNEXATION PROCESS, THE CITY AND THE COUNTY CAN ADDRESS AND TRY TO NEGOTIATE AN ALLOCATION OR REALLOCATION OF RHNA OBLIGATIONS. IN THE EVENT THEY CAN'T REACH AN AGREEMENT, THEY ARE FREE TO APPROACH S.C.A.G. AND ASK S.C.A.G. TO MAKE A DECISION. SO WE BELIEVE THAT PUTTING THIS AS PART OF THE POLICY OF ISSUES TO BE DISCUSSED WITH THE CITY IS ALREADY CONSISTENT WITH STATE LAW. IT'S AN ISSUE THAT THE CITY AND THE COUNTY SHOULD BE DISCUSSING AND, IN FACT, L.A.F.C.O. IS REQUIRED TO CONSIDER ALLOCATION, REALLOCATIONS IN CONSIDERING ANNEXATIONS. SO THIS WOULD NOT BE INCONSISTENT WITH STATE LAW. IF STAFF APPROACHED YOUR BOARD AND ASKED YOUR BOARD TO OPPOSE AN ANNEXATION BASED ON THE FACT THAT A CITY WAS NOT ACCEPTING WHAT THE COUNTY THOUGHT WAS AN APPROPRIATE ALLOCATION, THAT WOULD BE PROVIDED TO L.A.F.C.O., THAT WOULD NOT STOP THE CITY FROM APPROACHING S.C.A.G., OR, FOR THAT MATTER, THE COUNTY FROM APPROACHING S.C.A.G., BUT IT WOULD ALLOW THE COUNTY TO LET L.A.F.C.O. KNOW THAT THERE WAS A SIGNIFICANT DISAGREEMENT REGARDING WHO SHOULD BE RESPONSIBLE FOR REALLOCATIONS WITH RESPECT TO THE ANNEX AREA. 

SUP. KNABE: SO THE STATE LAW THAT THEY ARE REFERENCING IS ALREADY IN PLACE? IS THAT WHAT YOU'RE SAYING? 

RICHARD WEISS: YES, JANUARY 1ST -- 

SUP. KNABE: BECAUSE THEY REFERENCE SOME FUTURE CHANGE. 

RICHARD WEISS: THEY REFERENCED A PROPOSED LAW. UNLESS THEY'RE TALKING ABOUT SOMETHING ELSE THAT WE'RE UNFAMILIAR WITH. THERE WAS A NEW LAW THAT BECAME EFFECTIVE -- 

SUP. KNABE: WELL, LET'S SAY THAT THEY ARE. IF THAT WERE THE CASE, WOULD AT THAT POINT IN TIME, IF THE STATE CHANGED IT, WOULD WE BRING IT BACK TO MIRROR THE STATE LAW? 

RICHARD WEISS: WE WOULD BE REQUIRED TO ABIDE BY STATE LAW WHETHER OUR POLICY WAS INCONSISTENT. BUT I BELIEVE STAFF WOULD BRING BACK ANY INCONSISTENT POLICY IN ORDER TO RECONCILE IT WITH LATER ADOPTED STATE LAW. 

SUP. KNABE: OKAY. THANK YOU. 

SUP. ANTONOVICH: LET ME JUST FOLLOW UP AND REITERATE ONCE AGAIN, RICK, YOU'RE SAYING THAT, AND YOU'VE REVIEWED THE LETTERS FROM THE TWO CITIES, THAT THEY'RE ALLEGING THAT THIS DOES VIOLATE STATE LAW IS INCORRECT. 

RICHARD WEISS: YEAH. WE STRONGLY DISAGREE. WE DO NOT BELIEVE THIS POLICY VIOLATES STATE LAW. 

SUP. ANTONOVICH: AND THEY'RE JUST TRYING TO SLIDE THROUGH A LOOPHOLE AND CLAIM THAT IT VIOLATES STATE LAW, BUT IT'S NOT VIOLATING STATE LAW. 

RICHARD WEISS: IT DOES NOT VIOLATE STATE LAW. THEY MAY NOT AGREE WITH THE POSITIONS THAT STAFF MAY TAKE, BUT THAT DOES NOT MEAN THAT IT'S INCONSISTENT WITH STATE LAW. 

SUP. ANTONOVICH: MR. FUJIOKA, DOES S.C.A.G. EVER CONSIDER THE TERRITORY OF THE COUNTY AND EACH CITY WHEN IT'S SIGNING THESE RHNA NUMBERS? 

C.E.O. FUJIOKA: THE ANSWER IS YES. 

SUP. KNABE: BUT I MEAN, I THINK THE BIGGER ISSUE THERE WITH S.C.A.G., COULD I JUST INTERRUPT? I MEAN, S.C.A.G. DOES NOT HAVE CONTROL OVER LAND USE FOR THE COUNTY. IS THAT CORRECT? 

RAY FORTNER, COUNSEL: THAT'S TRUE. 

RICHARD WEISS: THAT'S TRUE, BUT THEY DO MAKE ALLOCATIONS, REGIONAL HOUSING NEEDS ALLOCATIONS. 

SUP. KNABE: THAT'S ENOUGH REASON TO OPPOSE IT RIGHT THERE. 

SUP. ANTONOVICH: WOULD THE AMENDMENT ALLOW THE COUNTY TO TRANSFER THE CORRESPONDING NUMBER OF UNITS TO THE CITY ANNEXING THE TERRITORY? 

LARI SHEEHAN: MADAM CHAIR, SUPERVISOR ANTONOVICH, IT DOESN'T ALLOW THE COUNTY, IT ALLOWS US TO NEGOTIATE WITH THE CITY UNDER THE POLICY AND IF WE REACH AGREEMENT, GIVE THAT TO L.A.F.C.O., IF WE DON'T REACH AGREEMENT, THEN IT ALLOWS US TO BRING THE ANNEXATION FORWARD TO THE BOARD TO OPPOSE THE ANNEXATION AND MAKE THAT KNOWN TO L.A.F.C.O. 

SUP. ANTONOVICH: AND BECAUSE WE HAVEN'T HAD THIS PROPOSAL BEFORE US DURING THE PAST 5 OR 10 YEARS, HOW MANY UNITS HAVE NOT BEEN TRANSFERRED TO CITIES THAT LOGICALLY SHOULD HAVE BEEN TRANSFERRED? 

LARI SHEEHAN: UNFORTUNATELY, I CANNOT ANSWER THAT QUESTION. I'D BE HAPPY TO DO SOME RESEARCH TO BRING AN ANSWER BACK TO YOU, BUT I DON'T HAVE THE ANSWER AT THE PRESENT TIME. 

SUP. ANTONOVICH: IF YOU CAN PROVIDE THAT LATER. I THINK THIS IS A VERY CONSTRUCTIVE AMENDMENT, IT CONFORMS WITH STATE LAW AND IT CLOSES A LOOPHOLE THAT HAD BEEN-- 

SUP. KNABE: WELL, WHAT IS THE LOOPHOLE THAT IT ACTUALLY CLOSES? WHY DO WE NEED THIS ORDINANCE? I'D AND THAT TO COUNSEL, I MEAN, VERSUS WHAT OUR ABILITY TO STOP PROJECTS IS TODAY? 

RICHARD WEISS: I THINK WE HAVE THE ABILITY TO NEGOTIATE WITH THE CITY AND TO ADVISE L.A.F.C.O. IF WE BELIEF THAT THIS ANNEXATION IS NOT APPROPRIATELY HANDLING RHNA ALLOCATIONS. PLACING IT IN A POLICY WOULD PROVIDE SOME CLARITY AND ALERT CITIES IN ADVANCE AND IN WRITING OF THE ISSUES THAT ARE, THAT THE COUNTY INTENDS TO BRING TO THE TABLE WHEN THEY SIT DOWN TO DISCUSS ANNEXATION. 

SUP. ANTONOVICH: MOVE THE MOTION. 

SUP. BURKE, CHAIR: WITHOUT OBJECTION, SO ORDERED. THERE WAS ONE OTHER ITEM THAT WAS BEING HELD. CS-1. DO YOU WANT TO CALL THAT, SUPERVISOR KNABE? 

SUP. KNABE: I DON'T WANT TO CALL BACK ANYTHING. 

SUP. BURKE, CHAIR: NO? ALL RIGHT. SUPERVISOR -- 

SUP. ANTONOVICH: CAN I DO MY ADJOURNMENTS? 

SUP. BURKE, CHAIR: YES. 

SUP. ANTONOVICH: LET ME ALSO ADJOURN, JOIN MY COLLEAGUE ON ADJOURNING IN MEMORY OF JOHNNY GRANT. REMEMBER, WE HAD HIM HERE ABOUT A YEAR OR SO, RECOGNIZING HIM FOR HIS CONTRIBUTIONS TO THE COUNTY. WE APPRECIATED JOHNNY'S VISION AND LEADERSHIP. HE IS REALLY THE MOTIVATOR AND THE INSTIGATOR BETWEEN THE VARIOUS GOVERNMENTAL AGENCIES FOR THE REVITALIZATION OF HOLLYWOOD. HIS COMMITMENT TO HOLLYWOOD AND THOSE WHO HELPED MAKE IT A GREAT COMMUNITY, WAS SECOND TO NONE. HE WAS ALSO VERY PROUD THAT HE HAD SERVED AS A BRIGADIER GENERAL IN THE CALIFORNIA STATE MILITARY RESERVE AND WAS QUITE INVOLVED IN HELPING OUR VETERANS FROM ALL THE WARS TO DESERVE THE RECOGNITION AND CREDIT FOR THEIR DEDICATION AND SERVICE. MORE IMPORTANTLY, HE WAS ONE OF THE KEY PEOPLE THAT GENE AUTRY TRUSTED AND RELIED UPON WHEN HE WAS BUILDING UP HIS GREAT NETWORK OF MEDIA AND OTHER INVESTMENTS THAT HAVE DONE SO WELL. BUT HE WAS A GOOD MAN, A VERY CHARITABLE INDIVIDUAL AND VERY SUPPORTIVE OF OUR COMMUNITY. ALSO I'D LIKE TO MOVE IN MEMORY OF ANOTHER VISIONARY AND LEADER WHO PASSED AWAY AT THE AGE OF 90 AND THAT WAS CARL KARCHER. I HAD THE PLEASURE OF KNOWING CARL AND WORKING WITH HIM FOR MANY YEARS, AND HIS FAMILY. INCREDIBLE PERSON, HIS EARLY INVESTMENT WAS IN AN AREA WHERE I WAS BORN AND RAISED IN SOUTH CENTRAL LOS ANGELES, WHICH TURNED INTO A SMALL HOT DOG STAND INTO A MULTIBILLION-DOLLAR ENTERPRISE THAT HAS EMPLOYED THOUSANDS AND THOUSANDS OF YOUNG PEOPLE. AND HE WAS VERY COMMITTED TO CHURCH, AND TO LIFE ISSUES AND VERY DEDICATED. HIS WIFE, MARGARET, WHO WAS HIS STRONG ALLY, PASSED AWAY A COUPLE YEARS AGO. BUT THEY WERE A GREAT INSPIRATION, ROLE MODEL. ALSO WE ADJOURN IN THE MEMORY OF FRANK GUERIN. HE WAS 90 YEARS OLD, AND HE HAD SERVED THREE TERMS AS DIRECTOR OF THE LOS ANGELES AREA CHAMBER OF COMMERCE, AND A DIRECTOR OF THE ARCADIA METHODIST HOSPITAL FOR 17 YEARS. JACQUELINE LEE BRISTOW FROM THE SAN DIMAS CITY WAS ACTIVE IN THE VENTURE CREW OF SCOUT TROOP 443 OUT OF COVINA. DONALD DUNN, THE DEAN OF THE UNIVERSITY OF LA VERNE COLLEGE OF LAW PASSED AWAY AT THE AGE OF 62. AND THAT WAS -- HE HAS SERVED THE LAW SCHOOL WITH GREAT DISTINCTION. HARVEY DURYEE, MEMBER OF THE PASADENA TOURNAMENT OF ROSES. KURT ROSS, WHO WAS A PROBATION OFFICER, TOO, FOR THE COUNTY OF LOS ANGELES FOR THE PAST 18 YEARS AND WAS INVOLVED IN THE ANTELOPE VALLEY AREA OFFICE. DR. RICHARD WEIKEL, PASSED AWAY AT THE AGE OF 69, MEDICAL DOCTOR. AND HE TRAINED AT THE UNIVERSITY OF CALIFORNIA LOS ANGELES MEDICAL SCHOOL AND DID HIS RESIDENCY AT L.A. COUNTY HOSPITAL. LOUIE VISCO, WHO OWNED AND OPERATED VARIOUS RECYCLING LANDFILLS AND INDUSTRIES IN THE SOUTHWEST. HE FOUNDED UNIVERSAL BY-PRODUCTS WHICH WAS LATER MERGED WITH WASTE MANAGEMENT IN 1972. A 50-YEAR PLUS MEMBER OF THE ROTARY CLUB. JOSEPH LEFFLER, WHO WAS A RETIRED DEPUTY SHERIFF. RICHARD GAETA, RETIRED LOS ANGELES COUNTY DEPUTY SHERIFF. WILLIAM BROWN, RETIRED SERGEANT OF LOS ANGELES COUNTY SHERIFF'S DEPARTMENT FOR 33 YEARS. AND ARMAND WESTFALL, PASSED AWAY JANUARY 7TH, ALSO WAS A DEPUTY LOS ANGELES COUNTY SHERIFF. HIS LAST ASSIGNMENT WAS IN THE ANTELOPE VALLEY. AND PETER BRETT POULTER, OF GLENDALE, PASSED AWAY ON CHRISTMAS DAY. DEPUTY JOSE ORMONDE PASSED AWAY AT THE AGE OF 39. HE WAS LOS ANGELES COUNTY DEPUTY SHERIFF AT THE SAN DIMAS STATION WHERE HE HAD SERVED THE DEPARTMENT FOR THE PAST 20 YEARS. THOSE ARE MY ADJOURNMENTS. 

SUP. BURKE, CHAIR: SO ORDERED. DO YOU HAVE ANY OTHER ITEMS? WOULD YOU LIKE TO CALL UP CS-1? 

SUP. ANTONOVICH: OKAY. CS-1. 

SUP. BURKE, CHAIR: BARBARA BLINDERMAN. 

BARBARA BLINDERMAN: MY NAME IS BARBARA BLINDERMAN. I'M ONE OF THE ATTORNEYS REPRESENTING ERNANI BERNARDI AND NOW HIS ASSIGNEES, JOHN CUPAL AND HOWARD JARVIS, TAXPAYERS' ASSOCIATION IN THE MATTER THAT YOU'RE GOING TO BE DISCUSSING IN CLOSED SESSION. I'D JUST LIKE TO BRING TO YOUR ATTENTION, SO THAT WE ALL REMEMBER WHAT THIS WAS ALL ABOUT WHEN IT STARTED. AND FROM MR. BERNARDI'S PERSPECTIVE, WHAT WE BELIEVE HAS BEEN ACCOMPLISHED IN THESE, IN THIS LITIGATION AGAINST THE COMMUNITY REDEVELOPMENT AGENCY AND THE CITY OF LOS ANGELES CONCERNING DOWNTOWN REDEVELOPMENT. NO MATTER WHAT THE RESULTS OF FURTHER LITIGATION ARE, WE BELIEVE WE'VE SUCCEEDED ON BEHALF OF THE BERNARDI PARTIES IN OUR ASSIGNMENT TO PROTECT THE 1977 JUDGMENT. THE APPELLATE COURT, AND THIS IS PRETTY FINAL, HAS DETERMINED TWO THINGS. ONE, THAT THE CITY, THE C.R.A., AND ALL OTHER PARTIES, ARE BOUND BY THE $750 MILLION LIMIT ESTABLISHED IN THE 1977 JUDGMENT AND CANNOT, IN ANY GUISE, ATTEMPT TO AVOID IT. SECONDLY, THAT THE CITY AND THE C.R.A. CANNOT, FOR THE LIFE OF THE CITY CENTER AND CENTRAL INDUSTRIAL PROJECTS, EXACT TAX INCREMENT FROM PROPERTIES FORMERLY WITHIN THE C.B.D. I LEAVE TO YOU TO READ THE REST OF IT. THE ONLY THING THAT I'LL READ IS TO REMIND YOU THAT WHEN THE CAP WAS SIGNED, MAYOR TOM BRADLEY SUPPORTED IT, SAYING, "WHILE IT'S UNLIKELY THAT THE REDEVELOPMENT PROJECT WILL RAISE AND EXPEND ANYWHERE NEAR $750 MILLION, IT'S A SAFE, CONSERVATIVE MAXIMUM CEILING PROVIDING THE CITY COUNCIL WITH A MARGIN FOR PRUDENT FLEXIBILITY." WELL, THAT WAS QUICKLY ATTEMPTED TO BE RAISED TO $7.1 BILLION AND THAT'S WHAT OUR FIGHT WAS ABOUT. JUST LIKE TO SAY THAT AS FAR AS -- WE DO HAVE SOME QUALMS ABOUT THE IDEA OF A PARTIAL VALIDATION, AND OF THE VALIDITY OF A PLAN WITH A 90% REDUCTION IN PROJECTED FUNDING. BUT OUR CHARGE HAS BEEN TO, AND REMAINS TODAY, PROTECTION OF THE TERMS OF THE 1977 JUDGMENT AS INTERPRETED BY THE COURT OF APPEALS DECISION. THANK YOU VERY MUCH. 

SUP. BURKE, CHAIR: THANK YOU. THERE'S NOTHING FURTHER, THEN PUBLIC COMMENT. 

CLERK SACHI HAMAI: PUBLIC COMMENT. 

SUP. BURKE, CHAIR: PUBLIC COMMENT. YES? 

SUP. YAROSLAVSKY: I'M JUST TRYING TO -- WOULD IT BE POSSIBLE FOR THE COUNTY COUNSEL, ON THE LAST -- ON MS. BLINDERMAN'S TESTIMONY, IS THERE ANYTHING YOU CAN SAY IN PUBLIC SESSION THAT ADDRESSES THE COUNTY'S POSITION ON THIS? 

RAY FORTNER, COUNSEL: MADAM CHAIR, SUPERVISOR YAROSLAVSKY, MY STAFF HAS BEEN IN CONTACT WITH BARBARA AND -- 

SUP. YAROSLAVSKY: HANG ON. BARBARA? BARBARA? I ASKED HIM TO RESPOND TO THE EXTENT POSSIBLE TO WHAT YOU HAD TO SAY, SO YOU SHOULD LISTEN. 

RAY FORTNER, COUNSEL: JUST TO CONFIRM THE CONVERSATIONS MY STAFF HAS HAD WITH BARBARA THAT THE CAP IS NOT IMPLICATED IN THE MATTER AND WOULD NOT BE IMPACTED AND THERE IS NO ATTEMPT TO EVADE THE $750 MILLION CAP ON THE INCREMENT THAT WAS IN THE BERNARDI JUDGMENT. 

SUP. YAROSLAVSKY: OKAY. THANKS. 

SUP. BURKE, CHAIR: JOHN NAHHAS, DION BICKHAM, AND MR. SACHS, DO YOU WANT TO START COMING DOWN? 

JOHN NAHHAS: GOOD MORNING, SUPERVISORS. MY NAME IS JOHN NAHHAS. THE CALIFORNIA COASTAL COMMISSION CAME TO MARINA DEL REY LAST WEEK, AND HEARD NEARLY 50 OUT OF THE 90 CITIZENS THAT HAD SIGNED UP TO SPEAK. COMMISSIONERS KINSEY AND CLARK STATED THAT THERE IS AN OBVIOUS DISCONNECT WITH THE COMMUNITY OF MARINA DEL REY AND LOS ANGELES COUNTY. THEY MOVED TO RECOMMEND THAT THE L.C.P. INCLUDE AN INDEPENDENT COMPREHENSIVE STUDY OF ALL PROPOSED DEVELOPMENT IN MARINA DEL REY THROUGH A COMMUNITY PLANNING PROCESS. COMMISSIONER BILL BURKE, SUPERVISOR YVONNE BURKE'S HUSBAND, INTENSELY SCRUTINIZED REGIONAL PLANNING'S RON HOFFMAN FOR HIS DEPARTMENT'S ROLE IN DISALLOWING COMMUNITY INVOLVEMENT IN THE L.C.P. REVIEW. THE CITIZENS WELCOMED COMMISSIONER BURKE'S CONCERN, BUT SOME OF US FEEL IT MAY HAVE BEEN MISDIRECTED. MR. KNABE, WE HAVE CONTINUALLY ASKED FOR YOUR PARTICIPATION OR A PUBLIC APPEARANCE. TO DATE, YOU HAVE NOT RESPONDED OR MADE ANY INCLINATION TO HEAR THE CONCERNS OF OUR COMMUNITY. COASTAL COMMISSIONERS, MARY SHALLENBERGER AND BILL BURKE RECOMMENDED THAT THE L.C.P. INCLUDE NO FURTHER REDUCTION OF BOATSLIPS IN MARINA DEL REY. AS I HAVE TESTIFIED IN FRONT OF YOU BEFORE, THE CONTINUOUS SLIP REDUCTIONS ARE DIRECTLY RESPONSIBLE FOR THE LIMITED SUPPLY AND THE ONSET OF PRICE GOUGING IN MARINA DEL REY. WITH 50 TO 60% INCREASES, HUNDREDS OF BOATING FAMILIES, MANY ON A FIXED INCOME, ARE NOW FACING SELLING THEIR BOATS, BEING EVICTED, OR LOSING THEIR BOATS FROM LIENS BY DEVELOPERS. IN 1984, THIS BOARD OF SUPERVISORS ESTABLISHED POLICY 27 TO PREVENT THIS VERY THING FROM HAPPENING. POLICY 27 REQUIRED THAT THE DIRECTOR OF BEACHES AND HARBORS INVESTIGATE ANY UNREASONABLE FEES OR INCREASES. BEACHES AND HARBORS, THE DIRECTOR HAS SURVEYED PRICES OF MARINAS WITHIN A 60-MILE RADIUS. ADMITTEDLY USING THE INTERNET WEB SITES OF THE DEVELOPERS FOR SLIP FEE DATA. THESE PRICES AND THE DIRECTOR'S SURVEY ARE THE DEVELOPER'S WISHES AND CLEARLY OVERESTIMATE WHAT BOATERS ARE WILLING TO PAY. WE CONDUCTED OUR OWN SURVEY OF WHAT THE VENDORS ARE ACTUALLY CHARGING RECREATIONAL BOATERS, 40% BELOW THE INTERNET PRICES. WHAT THIS MEANS IS, ONE, LOS ANGELES COUNTY IS ENGAGING IN USING FLAWED INTERNET DATA FOR PUBLIC POLICY. AND, 2, POLICY 27 WILL NEVER BE ENFORCED BECAUSE IT WILL BE BASED ON DEVELOPERS' OVER ESTIMATION OF VALUE. DR. ED MAHONEY, ONE OF THE LEADING EXPERTS IN BOATING ECONOMICS AND FOUNDER OF THE RECREATIONAL MARINE RESEARCH CENTER AT MICHIGAN STATE UNIVERSITY, HAS OFFERED HIS COMMENTS ON THE CRISIS IN MARINA DEL REY. IF THIS IS A PUBLIC MARINA THAT IS BEING SUBJECTED TO THESE FEES, THEN THE GOVERNMENT ENTITY SHOULD HAVE A POLICY RELATED TO THE EQUITY OF ACCESS AND PURPOSES OF THE MARINA. THE KEY IS TO COMPARE THE PRICE INCREASES WITH, AND, NUMBER 3, THE COST INCREASES FOR OTHER PUBLIC SERVICES PROVIDED BY THE ENTITY, INCLUDING OTHER FORMS OF RECREATION. IN SUMMATION, IF THE PUBLIC ENTITY HAS A POLICY OF SUBSIDIZING SOME RECREATION AND NOT OTHERS, THERE IS AN INCONSISTENCY THAT SHOULD BE EXAMINED. IF, IN FACT, THIS IS A PUBLIC MARINA, THEN THE PRICE INCREASES SHOULD RECOGNIZE EQUITY IN THE PURPOSE OF BUILDING THE MARINA AND IN THE FIRST PLACE, PUBLIC ACCESS. THANK YOU. 

SUP. BURKE, CHAIR: THANK YOU. COULD YOU PLEASE STATE YOUR NAME? 

DION BICKHAM: MY NAME IS DION BICKHAM. 

SUP. BURKE, CHAIR: DION BICKHAM. YES. 

DION BICKHAM: YES. I'M HERE TODAY ON BEHALF OF MY DAUGHTER-- 

SUP. BURKE, CHAIR: PARDON ME. COULD WE ASK OLGA RAMIREZ AND GAMIL YOUSSEF TO COME FORWARD? YES, PLEASE. UH-HUH? MR. BICKMAN? 

DION BICKMAN: I'M HERE TODAY ON BEHALF OF MY DAUGHTER. I AM A PARENT OF A, SORRY, OF A BABY GIRL THAT HAS DOWN'S SYNDROME AS WELL AS A HEART CONDITION. THERE'S CURRENTLY AN ISSUE GOING ON WITH HER AND WITH THE DEPARTMENT OF CHILDREN AND FAMILY SERVICES. RECENTLY MY CHILDREN WERE REMOVED FROM MY HOME BASED UPON ALLEGATIONS BY MY EX-WIFE. THESE ALLEGATIONS WERE PROVEN TO BE FALSE AND FURTHERMORE, IT WAS SHOWN BY A D.C.F.S. INVESTIGATIVE REPORT THAT SHE WAS ACTUALLY A 5150 CASE, SHE SUFFERS FROM SCHIZOPHRENIA AND THEREFORE CAN'T REALLY DIFFERENTIATE REALITY FROM FICTION. REGARDLESS OF THIS, D.C.F.S. HAS STILL RECOMMENDED THAT MY CHILDREN REMAIN IN PLACEMENT. AND I JUST, I NEED HELP WITH THIS. MY DAUGHTER HAS HAD A HEART SURGERY IN THE PAST. AND WHILE SHE WAS WITH ME FOR THE PAST TWO YEARS, WE WERE ABLE TO GET HER HEART FUNCTION UP FROM 20% TO 50%. BUT DURING THE MONTH THAT SHE'S BEEN IN PLACEMENT, SHE HASN'T BEEN WELL TAKEN CARE OF. AND NOW HER HEART FUNCTION IS CURRENTLY AT 20%, WHICH CONSTITUTES HEART FAILURE. AND I ACTUALLY HAD TO HAVE A CONVERSATION WITH MY DOCTOR, WITH HER CARDIOLOGIST, ON FRIDAY IN REGARDS TO HAVING A HEART TRANSPLANT FOR HER. IN ESSENCE, THE SITUATION HAS GONE ON WITH HER AS FAR AS ME NOT BEING WITH ME, AS FAR AS ME NOT BEING ABLE TO TAKE CARE OF HER, IS IN EFFECT COSTING HER HER LIFE, SO I'M JUST HERE BECAUSE I DON'T KNOW WHAT ELSE TO DO. I DON'T KNOW, I DON'T KNOW WHERE ELSE TO GO. 

SUP. BURKE, CHAIR: SOMEONE IS GOING TO TALK TO YOU. WE'LL TALK TO YOU AND SEE IF THERE'S ANY WAY THAT WE CAN AT LEAST FIND OUT FROM THE SOCIAL WORKER WHAT ALTERNATIVES THERE ARE. ALL RIGHT. MIRIAM WONG WILL SPEAK WITH YOU. MR. SACHS? 

ARNOLD SACHS: THANK YOU. I'D LIKE TO ADDRESS THE COUNCIL AND MAKE SOME COMMENTS ABOUT LAST WEEK'S MEETING AT THE CATHEDRAL PLAZA. IT'S TIME TO MOVE L.A., WHICH WAS A TRANSIT GET TOGETHER. THERE WERE SEVERAL ILLUSTRIOUS SPEAKERS, TALK ABOUT A CHALLENGE FROM PHIL ANGELIDES, INGLEWOOD CITY COUNCIL MEMBER, TABER, EDUCATE THE PUBLIC. SUPERVISOR YAROSLAVSKY WAS REQUESTING STRONG LEADERSHIP. AND YOU, SUPERVISOR BURKE, WERE TALKING ABOUT THE ACCOMPLISHMENTS AND THE M.T.A., BUT YOU ALSO HAPPENED TO MENTION THAT A LOT OF PEOPLE BLAME THE M.T.A. FOR THE FAILURE OF THE GREEN LINE TO REACH L.A.X. BUT ACTUALLY THE FAILURE WAS MORE DUE TO THE FACT OF THE F.A.A. WOULD NOT ALLOW THE GREEN LINE TO RUN UNDER THE RUNWAY, OR ACROSS THE THE PATH OF THE RUNWAYS. THAT BEING SAID, I WOULD JUST LIKE TO KNOW WHY, IF THE F.D.A., WHICH IS A GOVERNMENT AGENCY, A FEDERAL GOVERNMENT AGENCY, WOULD NOT ALLOW THE GREEN LINE TO BE RUN IN IT'S FORM THAT WAS OUTLINED, WHY WOULD THE M.T.A., WHY WOULD THE L.A. CITY COUNCIL, WHY WOULD A MEMBER OF THE STATE LEGISLATURE, PROPOSE LEGISLATION REQUESTING A GREEN LINE CONSTRUCTION AUTHORITY? UNDER WHAT TERMS WOULD THE F.A.A. CHANGE ITS MIND? WHEN THE SUBWAY TO THE SEA -- WHEN THE CONGRESS PASSED LEGISLATION NOT ALLOWING CONSTRUCTION OF THE SUBWAY TO THE SEA, NOT ALLOWING EXCAVATION, TUNNELING, NO LEGISLATION, NO PAPER WAS MOVED FORWARD BY M.T.A. BOARD, BY M.T.A. MEMBERS, TO REQUEST A CONSTRUCTION AUTHORITY FOR THE RED LINE, THE GREEN LINE, WHATEVER LINE TO THE SUBWAY TO THE SEA. YET HERE THE F.A.A. WOULD NOT ALLOW THE GREEN LINE TO TRANSVERSE UNDERNEATH THE RUNWAY, PAST THE RUNWAY SYSTEM. YET LEGISLATION IS ALLOWED TO MOVE THROUGH THE M.T.A. BOARD. THERE WAS A STUDY DONE, THERE WAS A 250,000 STUDY DONE AT THE REQUESTED BY THE CITY COUNCIL OF L.A., WHEN THE GREEN LINE WILL NOT BE ALLOWED TO EXIST AS A LIGHT RAIL LINE. WHAT ABOUT EDUCATING THE POLITICIANS, INSTEAD OF JUST EDUCATING THE PUBLIC? I'D ALSO LIKE TO TALK ABOUT LAST WEEK'S MEETING ON THE PROJECT 50, BUT ALL I WILL SAY RIGHT NOW AT THIS TIME, BECAUSE I'M GOING TO RUN OUT OF TIME, PLEASE, I DON'T MIND -- I APPRECIATE THE FACT YOU LET ME SPEAK IN FRONT OF YOU, BUT WHEN YOU HAVE ITEMS UP FOR DISCUSSION IN ADDITION TO JUST, THAT ARE ONLY GOING TO BE HELD BUT OPEN TO DISCUSSION, I'D LIKE TO BE ABLE TO TALK ON THOSE ITEMS AFTER THE DISCUSSION IS HELD. THANK YOU VERY MUCH. 

SUP. KNABE: MADAM CHAIR, COULD I JUST ADDRESS THE GREEN LINE ISSUE? THAT MAY HAVE BEEN THE CASE, BUT THE REALITY OF THE GREEN LINE, THE LAST LEG OF THE GREEN LINE INTO THE AIRPORT WAS REALLY TRADED FOR THE FIRST LEG OF THE RED LINE. THAT'S REALLY WHAT HAPPENED, TO GO TO THE SUBWAY. THE DYNAMICS AS IT RELATES TO THE F.A.A. AND THE RADAR AND RUNWAY ARE NO LONGER IN EXISTENCE. AND THAT'S EXACTLY WHY THE GREEN LINE AUTHORITY WAS SET UP, AND UNDER THAT PREMISE. BUT OBVIOUSLY THERE'S A STRUGGLE AND A LACK OF DOLLARS. BUT THE REALITY OF THAT LAST LEG, IT STOPPED BECAUSE THE CITY OF LOS ANGELES WANTED THE FIRST LEG OF THE RED LINE TO DO THE SUBWAY. AND THAT'S WHERE THE DOLLARS WENT FOR THE LAST LEG OF THE GREEN LINE. 

ARNOLD SACHS: THANK YOU. 

SUP. BURKE, CHAIR: THE OTHER PERSON WHO WISHES TO SPEAK, WOULD YOU COME FORWARD? STATE YOUR NAME, PLEASE. 

OLGA RAMIREZ: (SPEAKING SPANISH). 

(VOICE OF INTERPRETER): GOOD MORNING. MY NAME IS OLGA RAMIREZ. MEMBER OF THE COALITION OF THE LOS ANGELES COUNTY. I'M HERE BECAUSE I WAS HERE SIX MONTHS AGO, AND I SENT SOME LETTERS PETITIONING THAT WE NEED -- WE NEED JOSE RAIZ AND HIS GROUP TO COME AND WORK WITH US AND ALEJANDRO VELASQUEZ FROM THE DEPARTMENT OF PATIENT RIGHTS. THEY HAVE BEEN THE ONLY PEOPLE IN THE HEALTH DEPARTMENT THAT UNDERSTAND OUR CULTURE. AND THEY'RE VERY HONEST, THEY GIVE US THE SUPPORT TO FIGHT FOR OUR RIGHTS, AND THEY UNDERSTAND OUR CULTURE. IT WAS A SIMPLE LETTER, BECAUSE WE DON'T HAVE THE PREPARATION OR THE EDUCATION OF PEOPLE AT A HIGH EDUCATIONAL LEVEL. THE FIRST LETTER WAS WITH 40 SIGNATURES OF THE COALITION. AND IT'S BEEN SIX MONTHS SINCE THIS PETITION WAS SUBMITTED. I PERSONALLY GAVE ONE TO GLORIA -- SUPERVISOR GLORIA MOLINA. AND WE ALSO DELIVERED ONE TO HUMAN RESOURCES AT THE HEALTH DEPARTMENT, AND TO DR. SOUTHARD. AND UP TO NOW, WE JUST DON'T GET ANY ANSWERS. THE FIRST LETTER WAS SENT OUT ON JULY THE 18TH. THEREAFTER, WE PREPARED ANOTHER ONE WITH THE SAME TYPE OF PETITION. THEY'RE BOTH IN SPANISH, BUT THE SECOND ONE WAS A LITTLE MORE CLEAR AS TO WHAT THEY WANTED. WE DIDN'T DO IT IN ENGLISH, BECAUSE WE DON'T HAVE THE UNDERSTANDING OF THE LANGUAGE. I AM HERE NOW TO REQUEST -- TO REQUEST THAT I GET AN ANSWER TO THESE LETTERS. THESE TWO PERSONS THAT WE ARE TALKING ABOUT, JOSE RAIZ AND VELASQUEZ ARE THE ONLY TWO PEOPLE THEY HAVE WORK WITH US HONESTLY, WITH THE GROUP. AND WE DON'T KNOW WHY THEY HAVE BEEN PROHIBITED FROM DEALING WITH US. WE ARE CONSUMERS AS A GROUP AND WE PAY TAXES. AND WE HAVE THE RIGHT TO ASK. THE PEOPLE THAT WE THINK THAT CAN GIVE US THE SUPPORT AND HELP US. WE KNOW THERE WAS A CHANGE IN THE ADMINISTRATION, BUT DR. SOUTHARD HAS NOT GIVEN US ANY APPOINTMENTS OR ANY -- AND WE HAVE A LETTER SIGNED BY DR. SOUTHARD THAT NONE OF THE EMPLOYEES FROM THE HEALTH, MENTAL HEALTH, SHOULD INTERFERE WITH THIS GROUP. THIS IS HAPPENING TO THE DELEGATE IRMA MARTINEZ. SHE IS GIVING INTERNAL OPINIONS. THANK YOU VERY MUCH. 

SUP. BURKE, CHAIR: THANK YOU. 

SUP. MOLINA: (SPEAKING SPANISH) 

(VOICE OF INTERPRETER): WHEN THEY RESPONDED TO YOU, HOW COME YOU DON'T THINK THAT'S THE ANSWER TO YOUR LETTERS? 

OLGA RAMIREZ: (SPEAKING SPANISH). 

SUP. MOLINA: (SPEAKING SPANISH). 

(VOICE OF INTERPRETER): THEY HAVE RESPONDED TO YOU AND WE HAVE INFORMED YOU THAT IT'S A PRIVATE ENTITY. 

SUP. MOLINA: (SPEAKING SPANISH). 

(VOICE OF INTERPRETER): AND I'M TRYING TO GIVE YOU THE ANSWER NOW. 

OLGA RAMIREZ: (SPEAKING SPANISH). 

(VOICE OF INTERPRETER): THAT'S ALL I WANTED TO KNOW. 

SUP. MOLINA: (SPEAKING SPANISH). 

(VOICE OF INTERPRETER): WE HAVE RESPONDED TO YOU. WE'RE TRYING TO HELP YOU, BUT THIS IS A PRIVATE ENTITY. 

OLGA RAMIREZ: (SPEAKING SPANISH). 

(VOICE OF INTERPRETER): THE PEOPLE THAT ARE HELPING US ARE PRIVATE PEOPLE. 

SUP. MOLINA: NO. (SPEAKING SPANISH). 

(VOICE OF INTERPRETER): NO. THEY'RE PART OF THE COUNTY STAFF. 

OLGA RAMIREZ: (SPEAKING SPANISH) 

(VOICE OF INTERPRETER): I DON'T UNDERSTAND EXACTLY WHAT YOU'RE SAYING. WE HAVE BEEN TOLD THAT THE LETTER WAS TOO SIMPLE, THE WAY IT WAS WRITTEN, THE FIRST LETTER. 

SUP. MOLINA: (SPEAKING SPANISH). 

(VOICE OF INTERPRETER): WE UNDERSTAND... [ OVERLAPPING VOICES ] 

OLGA RAMIREZ: (SPEAKING SPANISH). 

(VOICE OF INTERPRETER): WE'RE SIMPLY ASKING WHY THOSE TWO PEOPLE THAT HAD WORKED WITH US ARE NOT ABLE TO WORK WITH US ANYMORE. 

SUP. MOLINA: (SPEAKING SPANISH). 

(VOICE OF INTERPRETER): THEY ARE COUNTY STAFF. THEY HAVE GOT OTHER RESPONSIBILITIES. 

SUP. MOLINA: (SPEAKING SPANISH). [ OVERLAPPING VOICES ] 

(VOICE OF INTERPRETER): BUT THEY CAN'T BE ASSIGNED BY THE COUNTY. 

OLGA RAMIREZ: (SPEAKING SPANISH). 

(VOICE OF INTERPRETER): MUY BIEN. THANK YOU VERY MUCH. 

SUP. BURKE, CHAIR: ALL RIGHT. WOULD YOU STATE YOUR NAME, PLEASE? 

GAMIL YOUSSEF: YES. MY NAME IS GAMIL YOUSSEF, AND IN FACT, I WORK FOR THE COUNTY OF LOS ANGELES FOR ABOUT SIX YEARS. AS I SAID, I WORK FOR THE COUNTY FOR ABOUT SIX YEARS IN THE DEPARTMENT OF THE PUBLIC SOCIAL SERVICE (OFF-MIKE). AND IN FACT, I'M PROUD OF MY RECORD AS AN OUTSTANDING WORKER. I RECEIVED SOME AWARDS. BUT I'M HERE FOR -- THERE WAS AN ARTICLE YESTERDAY IN THE L.A. TIMES, AND I'M SURE YOU ARE AWARE ABOUT THAT, REGARDING THE SETTLEMENT MEMOS. I REQUEST FROM THE COUNTY COUNSEL OFFICE TO RELEASE THE SETTLEMENT MEMOS, BECAUSE THE BOARD OF SUPERVISORS, THEY WILL NOT THE TRUTH, YOU WILL NOT KNOW THE TRUTH UNLESS YOU HEAR THE OTHER SIDE. THAT IS WHY I SUBMIT TO YOUR HONOR SOME COPIES OF RACIAL PROFILING. RACIAL PROFILING BY THE HUMAN RESOURCE OF LOS ANGELES COUNTY AND BY MR. MICHAEL HENRY HIMSELF. I THINK THIS IS VERY IMPORTANT ISSUE. I'M SURE THAT AS THE COUNTY COUNSEL, THEY DIDN'T SHOW YOU THE MEMOS, AND THEIR MEMOS, THE RACIAL PROFILING. THEY DIDN'T SHOW YOU IN THEIR MEMOS. THAT IS, WHEN I REPORT THE FRAUD TO MR. YAROSLAVSKY OFFICE AND MISS MOLINA OFFICE, I WAS RIGHT UH YOU HAVE A EMAIL, AND THE COPY I SUBMIT TO YOU TO SHOW THAT IS THE CASE IS, I REFERRED THEM TO FRAUD. IT WERE BAGGED UP, CORRECTED AND THEIR INSTRUCTION FROM THE DISTRICT NOT TO GIVE IT TO THE OTHER CONTROLLER UNLESS IT'S CORRECTED. I WAS ACTING IN GOOD FAITH. AND I AM HERE IN GOOD FAITH BECAUSE I DO BELIEVE YOU ARE A GOOD PEOPLE, YOU WILL STAND FOR WHAT IS RIGHT. BUT WHAT'S HAPPENING IN MY CASE, AND OTHER CASES, WE'RE REWARDING CORRUPTION, WE'RE REWARDING COVER UP, WE'RE REWARDING A LOT OF THINGS. I KNOW THAT IS, THE TIME IS LIMIT. THIS IS WHY I TRY IN THE COPY I SUBMIT TO YOU TO EXPLAIN VERY SERIOUS ISSUES INCLUDE ILLEGAL PRACTICE BY THE COUNTY COUNSEL OFFICE, THE COUNTY COUNSEL OFFICE. THE COUNTY COUNSEL OFFICE. AND MY ATTORNEY, AN OUTSIDE FIRM, AND I'M ASKING AND I ASKED MS. MOLINA BEFORE FOR AN INVESTIGATION, INDEPENDENT INVESTIGATION FOR MISUSED PUBLIC FUNDS. BECAUSE MY CASE, MR. YAROSLAVSKY, WOULD SOLVE IN FIVE MINUTES IF YOUR OFFICE AND THE OTHER OFFICES, THEY TOOK THE CORRECTIVE ACTION, I WOULD NOT BE HERE AND I'LL CONTINUE SERVING THE PUBLIC. I WISH YOU WOULD DO THE RIGHT THING AND TO CONDUCTING AN INDEPENDENT INVESTIGATION. AND AS I SAID TO YOU, MS. MOLINA, I WILL PROVIDE ALL THE EVIDENCE AND THE DOCUMENTATION WHICH IT WILL SUPPORT MY CLAIM. THANK YOU. 

SUP. MOLINA: MR. GAMIL? AGAIN, YOU'RE NOT MY CONSTITUENT, BUT THIS IS THE WORK THAT WE HAVE DONE ON YOUR PART, CONTACTS DIRECTLY WITH THE DEPARTMENT, INVESTIGATIONS THAT WE HAVE DONE, ALL OF THE WORK THAT WE HAVE DONE ON YOUR BEHALF, OKAY, PAGES AND PAGES. MY STAFF HAS SPENT HOURS AND HOURS WORKING WITH YOU. WE ARE AS INTERESTED AS ANYONE IN DETECTING FRAUD. BUT I THINK YOU'VE GONE BEYOND IT. WE CANNOT, JUST BECAUSE YOU ASK US TO NOW CONDUCT ANOTHER AUDIT, THAT IT'S GOING TO BE DONE ON YOUR BEHALF, BUT I DON'T WANT TO EVER DISMISS THAT YOU WERE NOT HELPED BY MY OFFICE, AS WELL AS OTHER OFFICES. THIS IS THE TIMES OF PHONE CALLS, THE CONTACTS, THE CALLS YOU MADE, THE LETTERS WE WROTE, THE INVESTIGATIONS THAT WE CONDUCTED. SIR, YOU CANNOT BE ABUSING US AS WELL, EITHER, BY SAYING WE HAVE NOT CARRIED OUT, JUST BECAUSE YOU THINK THAT YOU HAVE SOMETHING, AND WE INVESTIGATED EVERY ASPECT OF IT. SO I DON'T WANT YOU TO -- 

GAMIL YOUSSEF: DID YOU INVESTIGATE THE RACIAL PROFILING? 

SUP. MOLINA: SIR, YOU KEEP -- EVERY TIME WE COME UP WITH AN END TO ONE, YOU BRING UP ANOTHER. ALL RIGHT? AND YOU CONTINUE TO DO SO. I JUST WANT TO LET YOU KNOW THAT IT'S NOT LIKE WE'VE IGNORED YOU. THIS IS HOW THICK OUR FILE IS. 

GAMIL YOUSSEF: I THINK I SUBMIT TO YOUR HONOR DOCUMENTATION, VERY SERIOUS DOCUMENTATION AND EMAIL. AND I WISH THAT THEY WOULD INVESTIGATE THE MATTER. THANK YOU. 

SUP. BURKE, CHAIR: THANK YOU. 

SUP. YAROSLAVSKY: I BELIEVE YOU ALREADY HAD A LAWSUIT WITH THE COUNTY, DIDN'T YOU, AND IT WAS SETTLED? 

SUP. MOLINA: RIGHT. 

SUP. YAROSLAVSKY: IS THAT CORRECT? FOR $250,000? 

GAMIL YOUSSEF: THE CASE WAS SETTLED, BETWEEN MY ATTORNEY AND THE COUNTY COUNSEL, YEAH. IT IS NOT ABOUT THE MONEY, MR. YAROSLAVSKY. 

SUP. YAROSLAVSKY: I DIDN'T SAY IT WAS, BUT YOU HAVE BROUGHT AN ACTION WHICH WAS SETTLED OUT OF COURT. ARE YOU SUGGESTING THAT YOU WANT TO FILE ANOTHER SUIT? 

GAMIL YOUSSEF: NO, SIR. JUST I'M HERE, AS I SAID, IN GOOD FAITH BECAUSE, JUST LAST WEEK, I READ IN THE PAPER THERE IS ANOTHER LAWSUIT FILED AGAINST D.P.S.S. FOR NO CORRECTIVE ACTION. WHERE IS THE CORRECTIVE ACTION? THE DIRECTOR OF THE DEPARTMENT HERE WAS PROHIBITED-- 

SUP. YAROSLAVSKY: YOU KNOW, MR. YOUSSEF, IF YOU WANT TO READ ABOUT ALL THE LAWSUITS THAT ARE FILED AGAINST THE COUNTY, THERE'S A BETTER PLACE THAN THE PAPER. YOU CAN GO OVER TO THE COUNTY COURTHOUSE AND SEE, THERE ABOUT HALF A DOZEN A DAY THAT ARE FILED AGAINST THE COUNTY. NOT ALL OF THEM HAVE MERIT. IN FACT, MOST OF THEM ARE ADJUDICATED IN OUR FAVOR. SO JUST BECAUSE SOMEBODY FILES A LAWSUIT DOESN'T MEAN -- 

GAMIL YOUSSEF: MAY I SAY SOMETHING, MR. YAROSLAVSKY? DO YOU HAVE ANY EXPLANATION THAT THERE'S EVERYONE INVOLVED IN MY CASE AND MY ABUSE TO GET PROMOTED, INCLUDING THE DIRECTOR OF THE DEPARTMENT? 

SUP. YAROSLAVSKY: I GUESS I HAVE TO SHARE THE SAME COMMENT THAT SUPERVISOR MOLINA SHARED, WHICH IS NOT ONLY HAS HER OFFICE BEEN ACTIVELY AND AGGRESSIVELY INVOLVED, MY STAFF HAS BEEN SIMILARLY INVOLVED, THE COUNTY COUNSEL'S STAFF HAS PARTICULARLY BEEN INVOLVED, AND I GUESS THE REASON BOTH OF US WANTED TO JUST SAY THIS IS SO THAT THE IMPRESSION IS NOT LEFT AMONG PEOPLE WHO ARE WATCHING, THAT SOMEHOW NOTHING YOU'VE SAID HAS BEEN FOLLOWED THROUGH OR TAKEN SERIOUSLY. IT HAS BEEN TAKEN SERIOUSLY AND, IN FACT, IN YOUR PERSONAL CASE, AS I UNDERSTAND IT, IN A LEGAL ACTION YOU BROUGHT AGAINST THE COUNTY SOME TIME AGO, IT WAS SETTLED OUT OF COURT AND HERE YOU ARE AGAIN. SO AT SOME POINT, YOU KNOW, WE HAVE TWO MILLION CONSTITUENTS EACH. AT SOME POINT WE HAVE TO WORRY ABOUT THE OTHER 1,999,999, TOO. BECAUSE THEY ALSO CALL US AND EMAIL US, AND WE ONLY HAVE A LIMITED AMOUNT OF STAFF. SO I THINK YOU'VE BEEN GIVEN VERY, VERY GOOD THOROUGH TREATMENT, AND NOT YOU PERSONALLY, BUT YOUR ISSUES HAVE BEEN GIVEN VERY SERIOUS TREATMENT BY THE COUNTY FAMILY, AND -- 

GAMIL YOUSSEF: YOU THINK I RECEIVED A FAIR TREATMENT? 

SUP. YAROSLAVSKY: YEAH, I DO, I DO. 

GAMIL YOUSSEF: DO YOU BELIEVE THAT I RECEIVE A FAIR TREATMENT? 

SUP. YAROSLAVSKY: YEAH, I DO, I DO. I DO. AND WE MAY HAVE A DIFFERENCE OF OPINION, BUT -- 

GAMIL YOUSSEF: YES, I COMPLETELY DISAGREE WITH YOU. 

SUP. YAROSLAVSKY: OKAY. 

SUP. BURKE, CHAIR: ALL RIGHT. WE'LL NOW GO INTO CLOSED SESSION. CAN WE HAVE THE ANNOUNCEMENT. 

CLERK SACHI HAMAI: IN ACCORDANCE WITH BROWN ACT REQUIREMENTS, NOTICE IS HEREBY GIVEN THAT THE BOARD OF SUPERVISORS WILL CONVENE IN CLOSED SESSION TO DISCUSS ITEM NUMBER CS-1, CONFERENCE WITH LEGAL COUNSEL REGARDING EXISTING LITIGATION AS INDICATED ON THE POSTED AGENDA. THE NEXT REGULAR MEETING OF THE BOARD OF SUPERVISORS WILL BE JANUARY 22ND, 2008, AT 1:00 P.M. THANK YOU. 
REPORT OF ACTION TAKEN IN CLOSED SESSION ON JANUARY 15, 2008

CS-1. CONFERENCE WITH LEGAL COUNSEL - EXISTING LITIGATION (Subdivision (a) of Government Code Section 54956.9) County of Los Angeles v. Board of Directors, Community Redevelopment Agency of the City of Los Angeles, Los Angeles Superior Court Case Nos. BC 276472; C/W BC 277539. County of Los Angeles v. Board of Directors, Community Redevelopment Agency of the City of Los Angeles, Los Angeles Superior Court Case No. BC 288497. 
These lawsuits challenge the adoption of the City Center Redevelopment Project and Central Industrial Redevelopment Project. (07-1538) 
ACTION TAKEN: The Board approved the recommendation of County Counsel for terms of a settlement to resolve the County's challenge to the City Center Redevelopment Project (County of Los Angeles v. Board of Directors, Community Redevelopment Agency of the City of Los Angeles, Los Angeles Superior Court Case Nos. BC 276472; C/W BC 277539) in lieu of proceeding with an appeal in the Court of Appeal. 
The terms of the settlement will be made available upon inquiry by any person as soon as the settlement becomes final following approval by all parties. 
The vote of the Board of Supervisors was: 
Supervisor Molina: Aye

Supervisor Yaroslavsky: Aye

Supervisor Knabe: Aye

Supervisor Antonovich: Abstain

Supervisor Burke: Aye. 
In regards to Los Angeles Superior Court Case No. BC 288497 titled County of Los Angeles v. Board of Directors, Community edevelopment Agency of the City of Los Angeles, there was no reportable action taken. 
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